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Before You Begin Contents

Welcome to CreativEase

Welcome! This help guide holds everything you need to know about Pixelan Software's CreativEase collection of visual effects, which are available for
several video editing systems. Although the effects are deep and powerful, they do not have a steep learning curve -- a key benefit. Thus there is no need
for a thick manual or training CD, or a large time investment by you to use them effectively. (Hooray!) The easy, enjoyable way to learn is to step through
this concise guide with any of our effects visible on your screen.

If you are new to CreativEase and are wondering what these plug-ins can accomplish visually in your productions, please visit the
CreativEase area of our web site. Many example movies and images illustrate each plug-in.

To see how to APPLY CreativEase effects in your editing system, view the Please Read FIRST file in your Start > Program Files > Pixelan >
CreativEase menu. This is a VERY important step that we HIGHLY RECOMMEND for ALL users.

How to Use This Help System
This help guide includes basic info, tutorials, and advanced tips. To access it while using CreativEase, click the round ? button along the bottom of the
plug-in's window. For context-sensitive help, click the ? button at the top right of the window, then click on any item you want to learn more about. To view
the help anytime, even when not using CreativEase, choose Help from your Start > Program Files > Pixelan > CreativEase menu. Prefer to learn away
from your computer? A print-formatted Acrobat PDF version of this guide is at http://www.pixelan.com/cehelp/start.htm

Throughout the help pages, hot links are provided to related topics. Words in this color are commands, buttons, or areas in our plug-in interface. To
browse through topics, click any section at the left of this page, or click Contents at the top of this window.

The DEMO Version
If you have a demo, you can explore the intuitive interface, creative power, and other key features of CreativEase for an unlimited time. The demo is
identical to the purchased version EXCEPT all effects have an X over their image, and new saved settings cannot be created. If you later install the
purchased version, any demo effects in your project will instantly lose their X and retain all effect settings. No need to waste time
reapplying the same effects in your timeline!

Registration
If you purchased directly from Pixelan Software, you are ALREADY registered with us -- there is NO need to register. If you purchased from a reseller
(or had CreativEase plug-ins bundled in a different company's product), please register at http://www.pixelan.com/help/register.htm online. By
registering, you will be entitled to free technical support, be informed by email about the latest CreativEase updates as they arise, and receive the
guaranteed BEST prices on upgrades and future products.

Technical Support
We are dedicated to providing superb support. If you experience a problem, first look over the Please Read FIRST text file in your Windows Start >
Program Files > Pixelan > CreativEase menu. Common questions are answered there. For further assistance, visit
http://www.pixelan.com/help/techsupport.htm for help. From there, you can submit a help form that we will answer promptly by email, usually within a few
hours.

Enjoy CreativEase!

Sincerely,
Pixelan Software LLC
Bellingham, WA 98229 USA

© 2006 Pixelan Software LLC. All Rights Reserved. Pixelan Software and CreativEase are trademarks of Pixelan Software LLC. All other products
mentioned are for identification purposes only and may be trademarks or registered trademarks of their respective owners.

This guide, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of such license.
The information in this guide is for informational use only, is subject to change without notice, and should not be construed as a commitment by Pixelan
Software LLC. Pixelan Software LLC assumes no responsibility or liability for any errors, omissions, or inaccuracies that may appear in this Guide.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, recording, or otherwise, without the prior written permission of Pixelan Software LLC.

Most video clip images used in this guide are from the terrific royalty-free stock footage collection offered by www.creatas.com

Special thanks to our amazing code wizard Ivan Ivanov for making CreativEase's magic possible!
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Tutorial: How to Apply CreativEase Effects

STEP 1. Drag and drop a CreativEase effect onto a clip in your timeline. Generally, it is applied like built-in
effects in your video editing software. The steps are summarized in the Please Read FIRST file located in your Window's Start > Program Files > Pixelan >
CreativEase folder. After the effect's window appears, either:

STEP 2. Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the CreativEase effect window to
select a saved setting, which will instantly configure ALL CONTROLS
into a cool effect. Several subfolders are included, organized by style.
Single-click a saved setting to quickly preview and compare it to others.
Double-click your final choice.

.

Click any light-bulb in the effect window to choose a preset, which will
instantly configure controls ONLY IN THAT SECTION into a powerful
combination. Keep in mind you can do this while the preview plays.
Presets are a great way to QUICKLY build USEFUL effects from scratch,
or to modify a saved setting. Try a few -- THOUSANDS of combinations
are provided!

OR create a custom effect by manually adjusting. For a step-by-step tutorial on each CreativEase plug-in, click it's link:
PosterWise ChromaWarp 2 OrganiBlur BlurPro RiseShine FlowTexture 2 GrainPlus 2 SpatterFlex StepMotion 2 StepTime 2 CleanCrop

Step 3. Preview. In all CreativEase versions except for Sony Vegas/Vegas Movie Studio, to play or stop the preview, click the blue Play
button under the effect's preview, as shown below. Or drag the "scrub thumb" slider below the buttons to any desired frame. (Or, hold down the E key to
scrub to any frame. More shortcuts) Note you can loop-play the built-in preview continuously while making adjustments.

To go to a specific relative frame of the effect expressed as timecode (or frame count depending on preferences), enter the frame in the Current Frame box
that is left of the preview buttons, as shown above.

In Sony Vegas/Vegas Movie Studio, the above controls do not exist. Instead use your usual Vegas preview. Simply click in your Vegas timeline within
the event that has CreativEase applied. As you make changes in CreativEase, they will instantly appear in the Vegas preview. You can double-click an
event in the timeline to loop-play real-time while making CreativEase adjustments — highly recommended and very cool!

To match the vertical playback marker in the Keyframes graph of CreativEase to the Vegas timeline marker's position, Alt-click in the Keyframes graph (or
right-click there and choose Sync to Vegas timeline). This can be handy when setting up keyframes in CreativEase.

STEP 4. Apply the effect. Click the green Apply Current Settings 'check mark' button in the black bar area of the CreativEase window, as
shown below. To exit without changes, click the red Exit Without Changes 'X' button in the black bar (or the standard Close button at the top right of the
window).

Congratulations -- you are done! That's all for the basics!

Next page
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Tutorial: How to Apply CreativEase Effects (continued)

General Tips

** To clear all settings back to the default effect, click the yellow Clear '-' button in the black bar area. To set a NEW default for the effect, adjust
CreativEase controls as desired, then in the Prefs pane click the Set button. The new default will appear the NEXT time you apply the effect.

** To display two panes of CreativEase controls at once (handy when adjusting several controls), click the white triangle button in the top right corner of
the CreativEase window. (Note: In the Sony Vegas/Vegas Movie Studio version, several CreativEase effects already show two panes of controls and thus
may not have this button.)

** To easily experiment with different settings, CreativEase has 100+ undo/redo levels -- click the buttons circled below (or tap  Ctrl-Z / Ctrl-X
keys, respectively). If either is not available, the button will be dim.

For more details and tips, click any link below:

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts

Next page
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PosterWise Features    Tutorial Controls In Detail

Posterize effects in video editing programs look like an afterthought -- only adding a basic ability to limit the quantity of colors in a scene. Color edges
remain rough and unattractive, however, so the look is rarely useful. PosterWise in contrast is a CREATIVE break-through in posterize effects, giving you
enormous customization power. The plug-in's advanced algorithms allow you to easily form everything from cartoon-like animations from video to beautiful
abstract imagery.

Animate/Cartoon. QUICKLY
create cartoon-like animations from
video while RETAINING color
accuracy/stability over time (unlike
typical posterize effects).

Animate Titles in NEW
Ways. Apply PosterWise to create
unique title/text/logo effects with
flowing/changing color.

Smooth Edges. Smoothly
anti-alias color regions and borders -- a
key factor to make
posterizing/cartooning visually
appealing.

Electrify! Blend smooth,
adjustable borders and other edge
effects over your source image to create
electricity-like dynamics.

Renew & Revitalize. Easily
and attractively revitalize/customize
existing clips and stock footage for new
projects.

Customize Easily. With
intuitive control over colors, edges,
details, and blending, customize the
effect easily without frustration or lost
time.

Distill Essentials. Use
PosterWise to simplify images to their
most emotional/compelling artistic
elements.

Enjoy the Power. Choose from
several color models (RGB, HSV, HLS,
YUV and XYZ) for unique looks. Adjust
color channels individually. And much
more.

Accent Beautifully. Blend
abstract/sensual artistic styles (in many
different ways) with details from your
source image.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all PosterWise controls are bezier keyframable, you can smoothly smoothly vary individual aspects of the effect over time. Therefore you
can easily create PosterWise animations that evolve in visual character during your clip. Cool!

PosterWise Tutorial

PosterWise Controls In Detail

Next page
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PosterWise Tutorial    Features Controls In Detail

Apply PosterWise to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start
> Program Files > Pixelan > CreativEase menu.) After the PosterWise window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the PosterWise window to select
a saved setting, which will instantly configure ALL CONTROLS into a
cool effect. (If PosterWise's Saved Settings folder does not appear,
navigate to it.) Several subfolders are included, organized by style.
Single-click any saved setting to quickly preview and compare it with
others. Double-click your final choice.

.

Click any light-bulb in PosterWise to choose a preset, which will instantly
configure controls ONLY IN THAT SECTION into a powerful combination.
Keep in mind you can do this while the preview plays. Presets are a great
way to QUICKLY build USEFUL effects from scratch, or to modify a saved
setting. Try a few -- THOUSANDS of combinations are provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of PosterWise can be most
easily accessed in three steps:

STEP 1. Set Pre-blur and Posterization first. That's because they are the most important controls for using posterization to simplify your images.

Add or remove detail via  Pre-blur. Higher values tend to combine and smooth posterize color regions, making regions appear more rounded and
abstract.

Source image Pre-blur = 2 Pre-blur = 15

Adjust the posterization strength per color channel with the three Levels sliders. The higher the value, the stronger the posterization.

RGB Levels = 30 RGB Levels = 50

Set color differences by choosing from several color space options in the Model controls. For example, you can choose to match existing colors or

emphasize a particular area/color. Your adjustments will appear instantly in the built-in PosterWise preview. (In the Sony Vegas version, the effect will
appear real-time in the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

STEP 2. Add a border to the color edges (if desired). PosterWise features smooth, anti-aliased borders, a major advantage over other posterize
plug-ins. Use the Border controls to do this (click the Border tab to access them). Thin dark outlining will accent edges to create a cartoon-like look. Bold
glowing custom-color borders will produce abstract looks. Four border controls allow you to experiment with various border colors widths and styles.

STEP 3. Enhance other details (if desired). Additional options are available in Source section of controls, such as to outline object edges, to restore
source details, or to blend the posterized effect with the original image. Unlike the Border controls, applying black/color edges in the Source section will
trace OBJECT contours instead of level edges, adding a more sophisticated cartoon-like look. Restore Details will provide more details and realism, while
retaining a stylized look. The various Blend modes allow you to fine-tune the effect colors and details. You can reduce or enhance the effect over the entire
image or only in select image areas.

After creating a desired PosterWise effect, apply it by clicking the green "check mark" button in the lower right corner of the PosterWise
window. Click here for more applying tips.

For more details and tips, click any link below:

PosterWise Features
PosterWise Controls In Detail

Next page
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PosterWise Controls In Detail    Features Tutorial

To access useful presets per section, click the "light-bulb" button at the top-right of the Posterization, Border, or Source section.

Pre-blur

Pre-blur adds or removes detail in the PosterWise effect. Higher values tend to combine and smooth posterized color regions, making the regions appear
more rounded and abstract. To vary detail during the effect, keyframePre-blur.

Source image Pre-blur = 2 Pre-blur = 15

Two check boxes can modify Pre-blur:

Smart blur -- Turn on to retain more detail when strongly applying Pre-blur, especially within 10% to 30%.

Anti-alias-- Turn on to give all color regions a smooth, anti-aliased edge --- a major advantage over the jagged edges produced by typical posterize effects.

** Pre-blur occurs before other PosterWise processing. Therefore, it is usually a good idea to adjust Pre-blur first to roughly the value you want
before working with other controls.
** Depending on Pre-blur strength, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase the Crop frame
edge by value located below the Pre-blur slider. Or apply our powerful CleanCrop effect, if available to you.

Posterization

Model -- Use the Model menu to choose the color space PosterWise will use to process Levels (the posterization strength per color channel -- see below).
Each color space can produce different visual results. Five choices are available: RGB (red/green/blue, the default), HSV (hue/saturation/value), HLS
(hue/lightness/saturation), YUV, and XYZ. If you desire certain colors in your effect,HSL or HSV can be more intuitive than RGB. Set the H Level slider to
the colors you want, then adjust the other Level sliders.
Lock sliders -- To adjust all three Levels sliders (described below) simultaneously to the same value, turn on this checkbox.
Levels -- Three sliders provide individual control of the posterization strength per color channel. The higher the value, the stronger the posterization. A
100% value limits a channel to only two colors; 0% allows the maximum (256) colors in the channel to appear. For example, 100% value for all three
sliders in the RGB color space will create an effect with 2x2x2 = 8 colors.

RGB Levels = 30 RGB Levels = 50

** To posterize the scene to fewer than 8 colors, in RGB set all Levels to 100, then set one or two Offset sliders to -100 or +100. In HSV set all Levels
to 100, then set the H Offset and S Offset sliders to +100.
** To vary posterization during the effect, keyframe the Levels sliders. PosterWise will then smoothly animate the posterization strength per channel
during the effect. This is a major advantage over the integer-only number of levels produced by typical posterize effects, which produce sudden color
'jumps' if keyframed.

Next page
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PosterWise Controls In Detail (continued) Features Tutorial

Soften -- This control softens the posterized color regions, but not other elements such as Border and Source effects (see below). To vary softness during
the effect, keyframe Soften.

Border applied, Soften = 30 Soften = 80

Offset -- These three sliders shift where posterize color boundaries occur (i.e. color 'thresholds') in the image, and which colors per channel are used for
posterization. Use it to emphasize certain features or colors in the effect. To vary boundaries during the effect, keyframe any Offset slider.

HLS Model, Offset = 0 Offset = 40

Border

To create a wide range of borders around PosterWise color regions, five options are available in the Style menu:

Dark -- Applies a dark border related in hue to the color region it surrounds. Therefore, several colors of dark borders can appear in a clip.
Light -- Applies a light border related in hue to the color region it surrounds. Therefore, several colors of light borders can appear in a clip.
Relief -- Applies an emboss-like depth effect instead of a border.
Custom color -- Applies a single-color border throughout the clip. The color is selected by the eyedropper or color palette in the Color control.
Border over transparency -- Similar to Custom color option above, except all non-border areas of the clip become transparent to reveal overlapping clips
in lower tracks of your timeline. Note: This option previews only from your timeline. In Premiere 6.x, you must activate the clip's Alpha Channel key via
Premiere's Transparency option AND place the clip in track 2 or higher. In Avid Liquid, you must go into the Keying Editor, then for Key Type choose
Chroma Key or RGB Difference Key. Also, the CreativEase effect must be ABOVE Keying Editor in the clips' effect order or the effect will not appear. In
Ulead MediaStudio/VideoStudio,Border over transparency is not available.

Dark border Light border Relief border

Custom color border (white) Border only (w/ Custom color) Border over transparency

Border only -- Turn on this check box to have ONLY borders appear in the clip's image, as shown above. This control synergizes with all Style options
except Border over transparency.

Next page
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PosterWise Controls In Detail (continued) Features Tutorial

Color -- To choose a custom border color when Custom color, Border over transparency, or Border only is active, use the eyedropper or color palette in
the Color control. To match the border color to a color in your PosterWise effect (or any other color on your screen), click the eyedropper, then click on the
color desired. To apply a border color than is not already visible on your screen, click the color palette. Then click the Other button at the bottom of the
palette to access a standard Windows color picker. The color palette will store your 20 most recent color picker choices.
** To match the border color to a color in another clip, make the other clip visible on your screen, then open PosterWise for the new clip. Now move
the eyedropper tool over the other clip's image and click the desired color.
** To quickly match the border color to a color in the source clip (instead of the PosterWise effect), temporarily turn on the Border only option
(described above). Then use the eyedropper tool.

Width -- To change the width of all borders in the effect, adjust this slider. To vary border width during the effect, keyframeWidth.
Amount -- To adjust the intensity of all borders in the effect, use this slider. Higher values increase the border opacity, especially along its inner and outer
edge. To vary the border intensity during the effect, keyframeAmount.

Source
To creatively blend portions of a clip's source image with the PosterWise effect, experiment with nine compositing options in the Blend menu produce a
wide range of blends between the PosterWise effect and the clip's source image. The options are similar to blending modes found in programs such as
Adobe Photoshop. Use the Amount slider to set the strength of the chosen Blend option. Higher values show more of the clip's source image blended with
the effect. To vary Blend strength during the effect, keyframeAmount.
Normal -- Blends details from the source image uniformly throughout in the image, like a video dissolve.
Lighten -- Only blends in pixels from the source image that are lighter than the PosterWise effect.
Darken -- Only blends in pixels from the source image that are darker than the PosterWise effect.
Add -- Combines color values in the effect and source image, creating lighter colors. Black pixels remain unchanged and white pixels remain white.
Screen -- Lightens/brightens all colors in the PosterWise effect. Black pixels remain unchanged, however, and white pixels remain white.
Hard Light -- Selectively screens colors to produce a result that appears like a harsh lighting on the effect image.
Vivid Light -- Similar to Hard Light, but increases contrast in colors that are lighter than 50% gray. It therefore usually produces stronger colors than
Hard Light.
Linear Light -- Similar to Hard Light, but further brightens colors that are lighter than 50% gray. It therefore usually produces stronger colors than both
Hard Light and Vivid Light.
Color Dodge -- The lighter the effect color, the brighter the resulting color with this option turned on. Black pixels remain unchanged, however, and white
pixels usually remain white.

Six Add options provides several ways to add texture/details from the source image into the PosterWise effect. Use the Amount slider under the Add slider
to set the strength of the chosen option. Higher values show more texture/details. To vary the strength during the effect, keyframeAmount.Restore
details -- Source image details with a "High-pass" (or "unsharp mask") filter are added to the effect.
Relief -- Applies an emboss-like depth effect to source image details.
Color edges 2-way -- Similar to Relief, but applies color to some relief edges instead of only highlighting/shadowing.
Color edges 4-way -- Similar to Color edges 2-way, but applies color to all relief edges.
Black edges 2-way -- Similar to Color edges 2-way, but applies only black or gray to relief edges.
Black edges 4-way -- Similar to Color edges 4-way, but applies only black or gray to relief edges.

None Restore details Relief

Color edges 2-way Color edges 4-way Color edges 4-way (more Density)

Density -- Determines the visual density of the details produced by the chosen Add option, as shown in the last two images above. Higher values show
more extensive Add details. To vary the density during the effect, keyframeDensity.

Random and Seed --Used together, these two controls can randomize the colors created in the PosterWise effect, without affecting the color
shapes/boundaries. First move the Seed slider to a new value. Then drag the Random slider as desired. To vary or even cycle colors during the effect,
keyframe the Random slider. The controls are handy to create unusual treatments and to create fresh effects you may not have realized were possible with
PosterWise.

For more details and tips, click any link below:

PosterWise Features
PosterWise Tutorial

Next page
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ChromaWarp 2 Features    Tutorial Controls In Detail

Color effects are fairly standardized nowadays in most video editing systems, focusing on usual needs such as color correction, color elimination/retention,
uniform tinting, and basic hue changes. For music videos, creative spots, experimental work, and other cutting-edge projects, however, a CREATIVE AND
UNIQUE color effect is often needed -- which can be difficult to form with standard effects. That's when ChromaWarp 2.0 becomes handy, giving you the
power to:

Be Creative Quickly. Quickly
add creative color effects, from
cutting-edge color distortions to
glowing color warps -- in scenes or in
titles/logos/graphics.

Color WILD. Easily experiment
with color combos from different color
spaces, and useful/unusual variations of
film negative and other solarized looks.

Control WHERE. Gain new
versatility for everyday color correction,
tints, and brightness adjustments, too!
Use hundreds of Pixelan 'spices' to
easily mask WHERE such effects will
appear, without relying on rotoscoping,
mask files, etc.

Tint Subtle/FILM-Style.
Subtly colorize/tint/tone clips while
retaining full clarity and contrast in the
image, unlike standard tint effects.
Leave select areas untouched for extra
realism.

Get Real in The Mixer.
Enjoy our industry-unique Mixer control
to easily set the color effect in just light
or dark areas for fresh looks. Or to
realistically animate the effect along the
contours and details of your subject or
scene.

Smoothly Vary. Create
beautifully smooth color gradations in
your content, from subtle to
abstract/psychedelic.

Highlight Your Subject.
Softly and ORGANICALLY focus
attention on your subject with
ChromaWarp, using Photoshop-like
blending options.

Enhance Titles/Graphics.
Apply color effects, gradations, and
highlights (that are far more attractive
than 'canned' reflections) to animate
titles, logos, lower-thirds, and graphics.

Follow the Motion. Easily
alter the color only in light or dark
regions of a scene, or cycle from one
area to the other, as the effect moves
and follows your subject.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all ChromaWarp controls are bezier keyframable, you can smoothly vary individual aspects of the effect over time to create incredible cool
effects!

ChromaWarp Tutorial
ChromaWarp Controls In Detail

Next page

10

http://www.pixelan.com/images/ce/featurecw1-large.htm
http://www.pixelan.com/images/ce/featurecw6-large.htm
http://www.pixelan.com/images/ce/featurecw2-large.htm
http://www.pixelan.com/images/ce/featurecw7-large.htm
http://www.pixelan.com/images/ce/featurecw3-large.htm
http://www.pixelan.com/images/ce/featurecw8-large.htm
http://www.pixelan.com/images/ce/featurecw4-large.htm
http://www.pixelan.com/images/ce/featurecw9-large.htm
http://www.pixelan.com/images/ce/featurecw5-large.htm
http://www.pixelan.com/ce/movies.htm


Basic Steps Contents

ChromaWarp 2 Tutorial    Features Controls In Detail

Apply ChromaWarp to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's
Start > Program Files > Pixelan > CreativEase menu.) After the ChromaWarp window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the ChromaWarp window to
select a saved setting, which will instantly configure ALL CONTROLS
into a cool effect. (If ChromaWarp's Saved Settings folder does not
appear, navigate to it.) Several subfolders are included, organized by

style. Single-click a saved setting to quickly preview and compare it
with others. Double-click your final choice.

.

Click any light-bulb in ChromaWarp to choose a preset, which will
instantly configure controls ONLY IN THAT SECTION into a powerful
combination. Keep in mind you can do this while the preview plays.
Presets are a great way to QUICKLY build USEFUL effects from scratch,
or to modify a saved setting. Try a few -- more than 150 THOUSAND
combinations are provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of ChromaWarp is most easily
accessed in four steps:

STEP 1. Find a desired color combination. ChromaWarp's creative nature encourages experimentation, but to form a particular color distortion,
start by gradually adjusting one or more Warp sliders (in the Main pane) from their 1.0 RGB default. The Multiplier slider multiplies the value of the three
sliders above, giving you a quick way to change the strength of all channels at once. If necessary, select other color spaces at the bottom of the Main pane
to find a desired color combo. Below are but a few examples of endless color possibilities -- from subtle to strong. Note that they are NOT the typical
uniform tints and color changes produced by most other color effects. ChromaWarp instead adds beautiful color gradients and mixes.

Your adjustments will appear instantly in the built-in ChromaWarp preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will appear
real-time in the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

** To slightly change the image's hue, work in HSV or HLS color space, then adjust H and S sliders. (For subtle looks, be sure to set the Output slider
to 'return' the processing to the original color space, such as Input > RGB to HSV andOutput > HSV to RGB.) Note that ChromaWarp preserves
highlights and shadows better than most built-in color/tint effects.

** To create VERY wild color effects, click the Extras pane and experiment with the Channel Shift sliders. These sliders alter the color results per
channel, without changing the intensity of the ChromaWarp effect. Any whole number value, such as 0.0 or 1.0, does not change the image. In between
values, though, can alter the effect significantly. The Multiplier slider multiplies the value of the three sliders above, giving you a quick way to shift all

channels at once.

STEP 2. Add blurring and blending (if desired). In the Extras pane, increase the value of Blur if you desire beautifully smooth color gradations --
adding an interesting, more abstract look to the scene, from subtle to psychedelic. Then use the Blend menu and Amount slider to selectively return details
to the scene. Nine compositing options are available and are similar to blend modes in programs such as Adobe Photoshop. For example, to make the
ChromaWarp effect more subtle, choose Blend > Normal. To vary the strength during the effect, keyframeAmount.

Initial effect w/ Blur Initial effect w/ Blur (more) Blend > Normal

Next page
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ChromaWarp 2 Tutorial (continued) Features Controls In Detail

Initial effect Blend > Normal > Lighten > Darken > Add

> Screen > Hard Light > Vivid Light > Linear Light > Color Dodge

** To colorize text/logos in creative ways, apply ChromaWarp to an imported GRAYSCALE logo/text image file or to title clips created from a built-in
titler in your video editing program. Then set the Blur and desired Warps and Channel Shift. NOTE: ChromaWarp will not alter a still-image's alpha
channel, thus you may need to key out the image's black background in your timeline using another key in your system.

Original bitmap Example effects -- just a few from many creative possibilities

STEP 3. Keyframe to vary the color effect over time (if desired).Keyframing the Warp sliders from their default value can make a color
distortion gradually appear and/or recede. Keyframing the Blur slider can lead to interesting abstract defocusing color looks. Keyframing the Channel Shift
sliders can form unusual color-cycling effects. The variability of a ChromaWarp effect is one of its most unique qualities, so be sure to try our easy
keyframing -- it can open up a whole new realm of creative possibilities for you!

STEP 4. Limit or animate the effect area with a Pixelan spice. ChromaWarp utilizes the soft/organic power of Pixelan spices (derived from our
popular SpiceMASTER plug-in) to geometrically mask where the effect (created from other ChromaWarp controls) will appear within the frame. Click the
Spice tab to reveal spice controls to be used together with the Choose Spice File button and related settings in the center of the ChromaWarp window. The
Animate menu under the Spice tab provides several choices: Effect Mask, Warp,  Channel Shift, and Both.

With Effect Mask selected, you could have the ChromaWarp effect appear only where your subject is rather than over the entire image, for example, or
keep the ChromaWarp effect in outer areas to colorfully frame your subject. By keyframing the Position control, you can even have the effect area track
your subject's movement. By keyframing the Progress slider with an Iris spice, you could have the color effect flow from your subject organically outward
to the frame edge. Or wash the blur effect across the screen. (If you are familiar with our SpiceMASTER plug-in, Progress is just like Completion in
SpiceMASTER.)

Other Animate menu choices provide different looks than Effect Mask. Warp uses the chosen spice file to control where Warp will appear most intense.
Channel Shift sets where Channel Shift will be most intense. Both activates both of the above options -- Warp and Channel Shift. For more info about these
options, please see the next page.

Elliptic spice In soft area only Animate > Warp Animate > Both Mixer applied

Next page
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ChromaWarp 2 Tutorial (continued) Features Controls In Detail

To use the clip's luminance (instead of a spice file's luminance) to limit where the ChromaWarp effect appears within the image, set the Mixer slider to
100% at the bottom of the Spice section. To mix the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate value, such as 50%.
Experiment -- the Mixer is one of ChromaWarp's most unique and powerful controls. As shown in the image example above, the Mixer can be used to limit
your effect only on your subject (or any other part of the scene). Last but not least, keyframing the Mixer slider can lead to INCREDIBLE color flows within

your clip!

Original image Start of effect... Flowing... Flowing... Full frame

After creating a desired ChromaWarp effect, apply it by clicking the green "check mark" button in the lower right corner of the
ChromaWarp window. Click here for more applying tips.

For more details and tips, click any link below:

ChromaWarp Features
ChromaWarp Controls In Detail

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts
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ChromaWarp 2 Controls In Detail    Features Tutorial

To access useful presets per section, click the "light-bulb" button at the top-right of the Warp, Channel Shift, or Spice Effect section.

Warp
These sliders determine the intensity of the ChromaWarp effect per color channel, such as Red, Green, and Blue channels in the default RGB color space.

The Multiplier slider multiplies the value of the three sliders above, giving you a quick way to change ChromaWarp's strength in all channels at once.To
vary the color warp over time, keyframe any of the sliders.

Channels
ChromaWarp can process in several different color spaces, including RGB (the default), HSV, HLS, YUV and XYZ. This further expands the color effects it
can create for a wide range of imagery. If you have high-contrast or very light or dark clips, for example, a different color mode may create a desirable
effect in a way that RGB cannot. The Input submenu converts the event's image to the specified color space before the ChromaWarp effect is processed.
Likewise, the Output submenu converts after the effect is processed. Several presets are provided to help you explore the endless array of creative
possibilities. (For subtle looks, be sure to set the Output slider to 'return' the processing to the original color space, such as Input > RGB to HSV and
Output > HSV to RGB.)

Blur
Combining a blur with ChromaWarp's unusual color effects can create an endless range of fresh treatments, from subtle to psychedelic. Possible blur
values are from 0% to 100% and are of course keyframable.

Blend
Nine compositing options produce a wide range of blends between the ChromaWarp effect and the clip's source image. The options are similar to blending

modes in programs such as Adobe Photoshop. To set the strength of the chosen Blend option, adjust the Amount slider. Higher values show more of the
clip's source image. To vary the strength during the effect, keyframeAmount. (For example images, see the prior page.)
Normal -- Blends details from the source image uniformly throughout in the image, like a video dissolve. This is a handy way to make a ChromaWarp
effect uniformly more subtle.
Lighten -- Only blends in pixels from the source image that are lighter than the ChromaWarp effect.
Darken -- Only blends in pixels from the source image that are darker than the ChromaWarp effect.
Add -- Combines color values in the effect and source image, creating lighter colors. Black pixels remain unchanged and white pixels remain white.
Screen -- Lightens/brightens all colors in the ChromaWarp effect. Black pixels remain unchanged, however, and white pixels remain white.
Hard Light -- Selectively screens colors to produce a result that appears like a harsh lighting on the effect image.
Vivid Light -- Similar to Hard Light, but increases contrast in colors that are lighter than 50% gray. It therefore usually produces stronger colors than
Hard Light.
Linear Light -- Similar to Hard Light, but further brightens colors that are lighter than 50% gray. It therefore usually produces stronger colors than both
Hard Light and Vivid Light.
Color Dodge -- The lighter the effect color, the brighter the resulting color with this option turned on. Black pixels remain unchanged, however, and white
pixels usually remain white.

Channel Shift
These sliders alter the color results per channel, without changing the intensity of the ChromaWarp effect. Any whole number value, such as 0.0 or 1.0
or 2.0, does not change the image. Intermediate values, though, such as 1.5, can alter the effect significantly. The Multiplier slider multiplies the value of
the three sliders above, giving you a quick way to shift all channels at once.

Spice Effect
Like our popular SpiceMASTER plug-in, ChromaWarp utilizes our top-rated, industry-standard "spices" to generate fresh effects -- in this case, to
geometrically 'mask' where the ChromaWarp effect (established from the sections described above) will appear within the frame. Adjust Spice Effect
settings together with the Spice/Position controls described  at the bottom of this page.

Animate -- Each of the other options in this menu uses the luminance of a chosen spice file to alter the ChromaWarp effect in some way. Effect Mask
limits where the ChromaWarp effect will appear in the image. Warp uses the chosen spice file to control where Warp will appear most intense. Channel
Shift sets where Channel Shift will be most intense. Both activates both of the above options -- Warp and Channel Shift.

Progress -- Based on the selected spice file, this slider sets where the above Animate effect will be visible. (If you are familiar with our SpiceMASTER
plug-in, Progress is just like Completion in SpiceMASTER.) At 0% the effect will appear where blackest pixels reside (in the spice file's grayscale image,
not your content). At higher values, the effect will be visible where lighter grays reside in the spice file's image, and at 100% where the whitest pixels exist
in the spice file's image.

Softness -- Higher values soften the boundary of the spice mask.

Effect only in soft area-- Use this option to limit the ChromaWarp effect only to the Softness area (set by the above control). Increase the Softness value
to widen the effect area. Adjust the Progress slider to determine where the effect area appears.
Blur only in effect area-- When turned on, the Blur effect appears only where the ChromaWarp effect appears, not in the area masked by the spice file.

Mixer -- This unique control blends the spice and source clip's luminance to create a mask shape that is determined by your clip. At 100%, purely the
SOURCE clip's luminance is used as the effect mask. To mix using the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate
value, such as 50%. Experiment -- the Mixer is one of ChromaWarp's most unique and powerful controls. NOTE: Progress must not equal 0 or 100 for the
Mixer to have visual impact.

Invert Mixer-- Turn on this option to invert where the Mixer luminance mask forms in the source clip.

Next page
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ChromaWarp 2 Controls In Detail (continued) Features Tutorial

Spice/Position

In the center of the ChromaWarp window are the Choose Spice File button and related controls for positioning and modifying the Spice Effect. If you also
have our SpiceMASTER plug-in, the controls work identically. Click here for more details.

For more details and tips, click any link below:

ChromaWarp Features
ChromaWarp Tutorial

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
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OrganiBlur Features    Tutorial Controls In Detail

Built-in directional/radial blur effects typically blur only in one direction, outwardly, or as a spin. All have become overused effects. In contrast, OrganiBlur
can create thousands of fresh ORGANIC blur effects AND creative fluid-like looks -- by borrowing technology from our popular SpiceMASTER plug-in.

Swirl and Animate. Swirl and
animate blurs over time to tie the effect
into motion or other elements of your
scene.

Blur By Brightness. Use the
luminance of your clip to set the blur,
leading to very unique effects that
visually relate to your subject.

Apply the Unique. Easily
create numerous organic blur directions
that look truly FRESH and ORGANIC
instead of cliche.

Abstract & Symbolize. Use
OrganiBlur's power to abstract your
subject into new forms or symbols.

Make It Flow. Form incredible
fluid/liquid effects quickly using
OrganiBlur's intuitive controls.

Twist & Turn Titles. Apply
to titles/logos/graphics (in fact, any clip
with an alpha channel) for terrific
twists, spins, and flows.

Position & Move. Easily
position the blur location in your scene
and motion-track it with your subject if
desired.

Enjoy Creative Control.
Independently adjust position, intensity,
softness, angle, spread and other useful
blur qualities.

Customize With Spices.
Choose from hundreds of Pixelan
"spices" to determine the blur's origin,
direction and power.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

With powerful bezier keyframing for each control, you can smoothly animate individual aspects of OrganiBlur over time -- such as to have the organic blur
follow your subject's motion in the scene or to smoothly change in softness or other qualities. Cool!

OrganiBlur Tutorial
OrganiBlur Controls In Detail

Next page
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OrganiBlur Tutorial    Features Controls In Detail

Apply OrganiBlur to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start
> Program Files > Pixelan > CreativEase menu.) After the OrganiBlur window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the OrganiBlur window to select
a saved setting, which will instantly configure ALL CONTROLS into a
cool effect. Several subfolders are included, organized by style.
Single-click any saved setting to quickly preview and compare it with
others. Double-click your final choice.

.

Click any light-bulb in OrganiBlur to choose a preset, which will instantly
configure controls ONLY IN THAT SECTION into a powerful combination.
Keep in mind you can do this while the preview plays. Presets are a great
way to QUICKLY build USEFUL effects from scratch, or to modify a saved
setting. Try a few -- more than FOUR THOUSAND combinations are
provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of OrganiBlur is most easily
accessed in three steps:

STEP 1. Select the blur geometry. OrganiBlur uses the luminance of your clip's image or the luminance of a selected spice file (or a variable mix of
both) as the basis for the blur. To select from hundreds of available spice geometries (instead of using the default Elliptic1 C spice file), click the Choose
Spice File button at the center of the OrganiBlur window. (For more details about this button and related controls, click here.)

Note: With the Angle slider (described further in Step 2 below), you can control the blur direction, thus the default Elliptic1 C spice file for example can
also be used for spin, zoom and even spiral blurs. There is no need to select a spice file with exactly the desired blur DIRECTION -- selecting the basic
geometry alone is usually enough. Spice files that are curved in their geometry instead of rectilinear usually work best with this effect.

To instead use the clip's luminance to form the blur, set the Mixer slider in the Extras section of OrganiBlur to 100%. To mix the spice geometry AND your
clip's luminance, adjust the Mixer to an intermediate value, such as 50%. Experiment -- the Mixer is one of OrganiBlur's most unique and powerful
controls. Keyframing the Mixer slider can lead to incredible organic flowing blur effects.

original image elliptical spice blur luminance blur variation Mixer = 100

Your adjustments will appear instantly in the built-in OrganiBlur preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will instead appear
real-time in the Vegas preview.) Note you can even loop-play the effect while making adjustments. Click here for more preview tips.

 STEP 2. Adjust the blur direction and power. With Progress at its default 50%, adjust the Angle slider to the desired blur direction. Next use
Progress, Amount, and Spread sliders to adjust the blur's power. Progress is typically used to ramp the entire effect over time from 0% to 100% or back. (If
you are familiar with our SpiceMASTER plug-in, Progress is much like Completion in SpiceMASTER.) Amount controls the overall blur strength.

STEP 3. Fine-tune the effect. Spread controls how wide the blur appears from its origin. Ramping controls where within a directional blur the blur
appears strongest. For example, with the default Elliptic1 C spice file, set Progress to 50% and Spread to 1.0. Now set Ramping to 100% -- you get a
standard radial blur that has the maximum blur at the frame edge. Now set Ramping to 0%. You get a new radial blur effect with its maximum blur at the
center.

The Blur menu offers two additional choices. One-way can add distortions to the blurred areas, such as splatter diffusions and other artistic effects.
Two-way extends the blur length further.

Depending on OrganiBlur settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, at the bottom of the Main section

increase the Crop frame edge by value. Or apply our powerful CleanCrop effect, if available to you.

After creating a desired OrganiBlur effect, apply it by clicking the green "check mark" button in the lower right corner of the OrganiBlur
window. Click here for more applying tips.

For more details and tips, click any link below:

OrganiBlur Features
OrganiBlur Controls In Detail

Next page
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Preferences
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OrganiBlur Controls In Detail    Features Tutorial

To access useful presets per section, click the "light-bulb" button at the top-right of the Blur or Extras section.

NOTE: Words cannot do justice to the power of several of the controls below and their synergy. Please explore the available presets, as mentioned above,
and experiment with modifying control values to create truly unique effects.

Blur

Progress -- Progressively sets the extent of the blur established by other controls. Maximum is 50%. No blur appears at 0% and 100%. Thus the slider is
designed, when keyframed from 0% to 100%, to gradually increase the effect to a maximum and then decrease back to no effect during a clip. To just set a
static blur area during the entire clip, there is no need to keyframe -- just experiment with the slider to determine its best constant value for your desired
effect.
Blur -- Two-way blurs in two opposite directions; One-way in one direction.
Amount -- Controls the overall blur power.
Spread -- Specifies the size of the blurred area, as determined by the chosen spice file and/or Mixer value (see below). Values less than 1.0 blur only part
of the image. High values produce a uniform blur over the entire image, which is useful if you do not want to vary the blur amount within the image.
Angle -- The blur direction will follow the luminance gradient's direction unless you use this control to rotate the blur direction. Keyframing it can easily
create swirling blur effects.
Ramping -- At its 50% default value, the blur power has its maximum at the center of the blurred area and decreases toward the edges. Other values move
the blur maximum elsewhere within the blurred area. 0% moves the maximum to the beginning of the blurred area; 100% to the end.

Crop frame edge by -- Depending on OrganiBlur settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase this
value. Or apply our powerful CleanCrop effect, if available to you.

Extras

Softness -- Blurs the pixel basis used by OrganiBlur. Therefore, it can significantly smooth the blur direction/power variations, especially in fine-textured
source images when the Mixer is activated.

Input -- Like our popular SpiceMASTER plug-in, when the default Spice File choice is active, OrganiBlur utilizes our top-rated, industry-standard "spices"

to generate the effect. Use the Spice/Position controls described at the bottom of this page to adjust many aspects of the spice file.Or, you can base the
OrganiBlur effect on the Image's Luminance, which creates an entirely different/unique effect basis that relates directly to your image content.
Multiplier -- Only applies when Input > Image's Luminance is active. Controls how many times the blur repeats in each direction.

Mixer -- This unique control blends the spice and source clip's luminance to create a blur direction that is determined by your clip. At 100%, purely the
SOURCE clip's luminance is used as the basis for the blur. To mix using the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate
value, such as 50%. Experiment -- the Mixer is one of OrganiBlur's most unique and powerful controls. NOTE: Progress must not equal 0 or 100 for the
Mixer to have visual impact.

Invert Mixer-- Turn on this option to invert where the Mixer-based blur forms in the source clip.

Spice/Position

In the center of the OrganiBlur window are the Choose Spice File button and related controls for positioning and modifying the effect when it is based on a
spice file (thus Input > Spice File is chosen). If you also have our SpiceMASTER plug-in, the controls work identically. Click here for more details.

For more details and tips, click any link below:

OrganiBlur Features
OrganiBlur Tutorial

Next page
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BlurPro Features    Tutorial Controls In Detail

Typical blur effects alter the entire scene and are difficult to effectively mask, limiting their usefulness for digital video. BlurPro combines several blurs
and unique blend/mask tools into one plug-in, making it easy to SELECTIVELY SOFTEN your clips and/or create fresh animated blur effects. You can even
use it to nicely SHARPEN scenes without introducing typical sharpening artifacts. BlurPro therefore is very versatile for digital video. You gain the power
to:

Soften Yet Retain. Soften
areas AND retain edge definition (i.e.
smooth skin but keep fine hair,
eyelashes) so the overall scene does not
blur or lose depth.

Reduce Noise/ Artifacts.
INTELLIGENTLY reduce compression
'block' artifacts (i.e. from DV/MPEG/
JPEG), and pixel 'noise' by targeting
softness ONLY in low-light or solid color
areas.

Enhance the Sensual. The
opposite of above is also handy… easily
soften ONLY certain details (i.e.
blemishes, harsh reflections) to produce
lush/sensual visuals.

POP Your Subjects.
De-emphasize specific details or entire
background areas to enhance your
scene's center of interest -- where you
want your audience to FOCUS.

Be Dreamy/Surreal. Apply
just the right touch of SELECTIVE
softness to make dreamy/surreal looks
for wedding videos, dream segments,
and other special scenes.

Blur Uniquely/Animated.
Apply creative blurs and ORGANIC
animation that are difficult/impossible
with standard blurs, leading to uniquely
new visual effects.

Be Abstract/Arty. Selectively
soften scenes STRONGLY (while
retaining edge definition) to easily
create unique abstract/arty styles.

Improve OTHER Effects.
Get better/cleaner results by
pre-conditioning the image with BlurPro
before applying OTHER video effects to
a clip.

SHARPEN Better, Too!
BlurPro is also for sharpening!
SHARPEN only desired areas, accenting
details more effectively and reducing
unwanted sharpen 'halos.'

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

BlurPro leverages the soft/organic masking power of Pixelan "spices" (derived from our popular SpiceMASTER plug-in) to control blur location and
animation. With the powerful Mixer control, you can also use a clip's luminance to define effect areas -- an easy way to soften only light or dark regions, for
example, or to create compelling new blur effects. Last but not least, BlurPro's bezier keyframing can form incredibly DYNAMIC blurs that smoothly
change and evolve over time.

BlurPro Tutorial
BlurPro Controls In Detail

Next page
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BlurPro Tutorial    Features Controls In Detail

Apply BlurPro to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start >
Program Files > Pixelan > CreativEase menu.) After the BlurPro window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the BlurPro window to select a
saved setting, which will instantly configure ALL CONTROLS into a cool

effect. (If BlurPro's Saved Settings folder does not appear,
navigate to it.) Several subfolders are included, organized by style.
Single-click a saved setting to quickly preview and compare it with
others. Double-click your final choice.

.

Click any light-bulb in BlurPro to choose a preset, which will instantly
configure controls ONLY IN THAT SECTION into a powerful combination.
Keep in mind you can do this while the preview plays. Presets are a great
way to QUICKLY build USEFUL effects from scratch, or to modify a saved
setting. Try a few -- more than FIVE THOUSAND combinations are
provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of BlurPro is most easily
accessed in four steps:

STEP 1. Select the type of blur and set its strength. In the  Blur > Type section, Box,  Fast, and Gaussian options are available. Gaussian is
highest quality but slowest to render. Adjust the blur's strength with the Amount slider. To vary the blur strength during the effect, keyframeAmount.

Your adjustments will appear instantly in the built-in BlurPro preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will instead appear
real-time in the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

STEP 2. Stylize the blur effect. Use the Style section to selectively preserve edges, to keep highlights or shadows unchanged, or to sharpen the
entire image or only certain edges. BlurPro makes it easy to selectively sharpen some image areas but soften others, thus a wide variety of uniquely
beautiful custom looks are possible. Adjust the Amount slider to determine the style's strength. For Preserve Edges, Unsharp Edges and Blarpen options,
Amount sets the "threshold" and therefore an optimal value is typically 10-30%. To vary the style's strength during the effect, keyframeAmount. After
activating a style, you may need to fine-tune Blur > Amount further (see Step 1 above).

ORIGINAL image Preserve Edges Pres. Edges (more) Blur Light Blur Light (more)

Blur Dark Blur Dark (more) Unsharp Mask Unshrp. Mask (more) Unsharp Edges

Blarpen Blarpen (more) Blarpen (softer) High-Pass Light Relief

Light Relief (more) Light Relief (softer) Dark Relief Dark Relief (softer) Relief

** Blur > Amount and Style > Amount can be set to extreme values to create some very unique looks, as shown above. And keep in mind you can apply
BlurPro more than once to the same clip to emphasize certain features with each pass. Abstract effects, very cool animated looks, soft dreamy styles, and
more are possible. Experiment!

** Depending on BlurPro settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase the Crop frame edge by

value located below Blur > Amount. Or apply our powerful CleanCrop effect, if available to you.

Next page
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BlurPro Tutorial (continued) Features Controls In Detail

STEP 3. Blend the effect with the source image (if desired). Blending the effect with the source image can produce a different look than simply
decreasing Amount sliders. Experiment with the Source control if you desire to strengthen detail or color in your clip while still retaining some softening.
Higher values show more of the clip's source image. To vary the strength during the effect, keyframeSource.

Original image Preserve Edges (high) Source > Amount = 50

TIP: While adjusting settings for a subtle BlurPro effect, to more easily see where it will modify the image, temporarily choose Style > High-Pass.

STEP 4. Limit or animate the effect area with a Pixelan spice. BlurPro utilizes the soft/organic power of Pixelan spices (derived from our popular
SpiceMASTER plug-in) to geometrically mask where the effect (created from other BlurPro controls) will appear within the frame. Click the Spice tab to
reveal spice controls to be used together with the Choose Spice File button and related settings in the center of the BlurPro interface.

You could have the BlurPro effect appear only where your subject is rather than over the entire image, for example, or keep the BlurPro effect in outer
areas to softly frame your subject. By keyframing the Position control, you can even have the effect area track your subject's movement. By keyframing the
Progress slider with an Iris spice, for example, you could have the blur flow from your subject organically outward to the frame edge. Or wash the blur
effect across the screen. (If you are familiar with our SpiceMASTER plug-in, Progress is just like Completion in SpiceMASTER.) Using the powerful and
unique Mixer slider, you can alter the spice geometry to match your content, so that BlurPro effect is in just light or dark areas. The creative possibilities
are nearly infinite!

Original image Gaussian Blur (high) Elliptic spice over eye to preserve
detail.

Mixer applied to modify elliptic
mask to match eye

Note that to see Mixer results, Spice Effect > Effect must be On and Progress must not equal 0 or 100.

After creating a desired BlurPro effect, apply it by clicking the green "check mark" button in the lower right corner of the BlurPro window.
Click here for more applying tips.

For more details and tips, click any link below:

BlurPro Features
BlurPro Controls In Detail

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts
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To access useful presets for each major section, click the "light-bulb" button at the top-right of the Blur or Spice Effect sections.

Blur
These initial controls are simple and most familiar. Box, Fast, and Gaussian are available in the Type menu, with Gaussian highest quality but slowest to
render (just like in Photoshop) and Box fastest but lower quality. Set the blur strength (radius) with the Amount slider. To vary the blur strength during the
effect, keyframe Amount.

Depending on BlurPro settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase the value of Crop frame edge
by which is located below Blur > Amount. Or apply our powerful CleanCrop effect, if available to you.

Style
Use the Style section to create many useful variations of a standard blur. This is where BlurPro's unique power becomes evident. Ten options are available

in the Effect menu. To set the strength of the chosen Style option, adjust the Amount slider. To vary the strength during the effect, keyframeAmount. For
example images of each option below, see the prior page.
Preserve Edges -- This option blurs the image, but retains high-contrast details. It works especially well with the Gaussian blur. The Amount slider
controls the extent of preserved details. This is a great way to nicely smooth/remove slight blemishes on a subject or image.
Blur Light -- Use this option to soften light areas of an image, while retaining detail in dark areas. Increasing the Amount reveals more dark area detail.
Blur Dark -- The inverse of the above option: blur only dark areas, while retaining detail in light areas.
Unsharp Mask -- This option increases contrast around high-contrast edges, just like the similar effect in Photoshop. The Amount slider sets the radius of
the sharpened area. The greater the radius, the larger the edge effect and potential "halo". Unless you desire an abstract look, small values therefore
usually appear best. What is unusual about BlurPro is the easy combination of blurring with Unsharp Mask, allowing you to selectively blur AND sharpen
the image. Note that you must have at least a some Blur > Amount active to apply this sharpening.
Unsharp Edges -- Similar to Unsharp Mask, but here the Amount slider works as a threshold control instead of radius. The threshold determines how
different a pixel must be from adjacent pixels to be sharpened by this option. Thus you can easily enhance only high-contrast details. Use the Source slider
(see below) to decrease the overall effect.
Blarpen -- This funny-named option strengthens high-contrast edges but simultaneously softens the rest of the image. It is a great choice to easily produce
surreal "dreamy" looks while retaining detail, such as for wedding videography. Like for Unsharp Edges, the Amount slider works as a threshold control --
how different the pixels must be from adjacent pixels to be affected by this option. Useful values are typically from 10-30%. Use the Source slider (see
below) to decrease the overall effect.
High-Pass -- This option retains only the image details engraved over a gray background. By itself, a high pass look is not often desirable, but in BlurPro it
can be combined with the Source slider (see below) to variably bring color back into the image. Cool!
Light Relief -- Adds a light "relief" look selectively to highlights in the blurred image. A creative way to enhance highlights.
Dark Relief -- The inverse of the above option: adds a dark relief look only to darker areas in the blurred image.
Relief -- Choose this option to apply a relief effect to the blurred image. In combination with the Source slider (see below) you can selectively retain color
and details.

Source
Use this slider to variably blend the effect with the original image. Higher values decrease the overall effect's strength, usually creating a different look
than simply decreasing the Effect > Amount slider.

Spice Effect
Like our popular SpiceMASTER plug-in, BlurPro utilizes our top-rated, industry-standard "spices" to generate fresh effects -- in this case, to geometrically
mask where the BlurPro effect (established from sections described above) will appear within the frame. Adjust Spice Effect settings together with the
Spice/Position controls described at the bottom of this page.

Effect -- An on/off control for the spice effect.

Progress -- Based on the selected spice file, this slider sets the area where the BlurPro effect will be visible. At 0% the effect will appear where blackest
pixels reside (in the spice file's grayscale image, not your content). At higher values, the effect will be visible where lighter grays reside in the spice file's
image, and at 100% where the whitest pixels exist in the spice file's image.

Softness -- Higher values soften the boundary of the spice mask.

Effect only in soft area-- Use this option to limit the BlurPro effect only to the Softness area (set by the above control). Increase Softness to widen the
effect area. Adjust the Progress slider to determine where the effect area appears.

Mixer -- This unique control blends the spice and source clip's luminance to create a mask shape that is determined by your clip. At 100%, purely the
source clip's luminance is used as the effect mask. To mix using the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate value,
such as 50%. Experiment -- the Mixer is one of BlurPro's most unique and powerful controls. NOTE: Progress must not be 0 or 100 for the Mixer to have
visual impact.

Invert Mixer-- Turn on this option to invert where the Mixer luminance mask forms in the source clip.

Spice/Position
In the center of the BlurPro window are the Choose Spice File button and related controls for positioning and modifying the Spice Effect. If you also have
our SpiceMASTER plug-in, the controls work identically. Click here for more details.

For more details and tips, click any link below:
BlurPro Features
BlurPro Tutorial

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts

22



Basic Steps Contents

RiseShine Features    Tutorial Controls In Detail

Although most video editing programs can apply depth to titles, such as bevels, the results tend to look "engineered" rather than artistic. Also, built-in
lighting controls, if they exist at all, tend to provide unconvincing highlights and no ability to creatively gloss surfaces, unless you detour the title into
complex motion graphics software. That's where the convenience and power of RiseShine pays big dividends. Instantly and easily add beautiful, realistic
depth AND apply glossy/wet surface treatments as desired -- not only to titles, logos and graphics but ALSO to regular video clips!

Leave Flat Behind. Quickly
add realistic, smooth depth to titles,
logos, lower-thirds, or alpha-channel
graphics -- forming attractive 'objects'
rather than flat fonts.

Synergize with Other FX.
RiseShine synergized with OrganiBlur,
FlowTexture, or PosterWise easily
creates a wide range of unique looks for
titles, logos, graphics, etc.

Polish the Gloss. Apply an
adjustable shiny gloss/polish to your
title objects -- much more compelling
than the typical dull glints in most
built-in titlers.

Look Uniquely Glassy. By
applying RiseShine together with
OrganiBlur, you can create fantastic
glass/marbled fonts unlike anything else
in the industry.

Adjust the Reflections.
Lighting is easily adjustable and bezier
keyframable, allowing you to move
reflections on objects as the title moves,
for further realism.

Add Shine/Depth to
Video. RiseShine isn't just for titles!
It can also usefully add shine and depth
to regular video clips, targeted to the
luminance of the imagery.

Light the Neon. Incredibly cool
and REAL neon looks can be instantly
produced from virtually any regular
font, and can be pulsed and flowed
easily.

Wet Your Subjects.
RiseShine can seamlessly add a
convincing wet surface look to your
video subjects, even if the footage was
not originally shot with a wet look. Wild!

Power Your Fonts. Use
RiseShine to quickly modify your
existing common fonts into fresh,
creative new looks that can change and
evolve over time.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all RiseShine controls are bezier keyframable, you can smoothly vary individual aspects of the effect over time to create incredible flowing
font changes and effects!

RiseShine Tutorial
RiseShine Controls In Detail

Next page
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RiseShine Tutorial    Features Controls In Detail

Apply RiseShine to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start >
Program Files > Pixelan > CreativEase menu.) After the SpatterFlex window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the RiseShine window to select a
saved setting, which will instantly configure ALL CONTROLS into a cool
effect. Several subfolders are included, organized by style. Single-click
any saved setting to quickly preview and compare it with others.
Double-click your final choice.

.

Click any light-bulb in RiseShine to choose a preset, which will instantly
configure controls ONLY IN THAT SECTION into a powerful combination.
Keep in mind you can do this while the preview plays. Presets are a great
way to QUICKLY build USEFUL effects from scratch, or to modify a saved
setting. Try a few -- they're great! 

OR create a custom effect by manually adjusting. For this latter approach, generally the power of RiseShine is most easily
accessed in two steps:

STEP 1. Set the general strength and gloss. Adjust the first four sliders in the Shine section -- Intensity, Softness, Gloss, and Height -- until a
desired look is generally reached. These controls tend to have the most profound impact on the RiseShine effect. If you are applying RiseShine to a title
clip or other alpha-channel graphic, be sure to select Alpha in the Channel submenu AND turn on the Mask with Alpha Channel check box at the bottom of
the Shine section.

Instead of using a clip's luminance (pixel brightness/darkness) or alpha channel to mask the RiseShine effect, you can choose an RGB color channel in the
Channel submenu. This is handy if your scene features well-defined color objects that you want to focus the effect on.

Your adjustments will appear instantly in the built-in RiseShine preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will instead appear
real-time in the Vegas preview.) Note you can even loop-play the effect while making adjustments. Click here for more preview tips.

STEP 2. Fine-tune the effect. Use the remaining controls in the Shine and Extras sections to fine-tune the effect.

Depending on RiseShine settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, in the Extras section increase the

Crop frame edge by value. Or apply our powerful CleanCrop effect, if available to you.

After creating a desired RiseShine effect, apply it by clicking the green "check mark" button in the lower right corner of the RiseShine
window. Click here for more applying tips.

For more details and tips, click any link below:

RiseShine Features
RiseShine Controls In Detail

Next page
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Preferences
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To access useful presets per section, click the "light-bulb" button at the top-right of the Shine or Extras sections.

Shine

Intensity --Determines the strength of the overall effect, from 0% to 100%, produced by all other controls below.
Softness -- Blurs the light source to soften the overal effect and reduce details.
Gloss -- Higher values increase the visual hardness of the reflections, thus creating a realistic wet/glossy look.
Height -- Higher values increase the height of the shine/reflections (or font depth if applied to a title or other alpha channel
graphic).
Ambient -- Adds a constant value to the overall lighting, which can moderate font depth produced by the Height control.
Shadow -- Strengthens shadows/relief in the effect, which can produce a feeling of greater depth especially with a title or other
alpha channel graphic.
Channel -- Luminance is the default and the most likely choice for most video clips, which uses the clip's luminance (pixel

brightness/darkness) to mask the RiseShine effect. If your scene features well-defined color objects that you want to focus the effect on, instead choose an
RGB color channel. For titles or other alpha channel graphics, however, always choose Alpha.

Mask with Alpha Channel  -- To create RiseShine's unique depth/shine effects in titles or other alpha channel graphics, always turn
on this option.

Extras

Angle -- Sets the angle of the simulated light, from 0 degrees (image right) rotating counter-clockwise to 360 degrees (return to
image right).
Blend -- In addition to the usual Normal light blending, Add and Multiply are provided to vary the effect.
Light 2  -- Adds a secondary light source, which in a video clip can bring more detail back into the effect. On a font or other
alpha channel graphic, it extrudes the edge of the text/graphic, which sometimes can better define the element against its
background.
Invert Light 2  -- Inverts the above control's effect.
Crop frame edge by -- Depending on RiseShine settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase this

value. Or apply our powerful CleanCrop effect, if available to you.

For more details and tips, click any link below:

RiseShine Features
RiseShine Tutorial
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FlowTexture 2.0 is the next generation of our unique flowing displacement effect tool. It is much more powerful than standard displacement effects, which
tend to be not very adjustable and only create a few kinds of (mostly unattractive/unusable) wave/ripple/emboss looks. FlowTexture instead creates
fully-adjustable realistic water drops AND creates an almost infinite array of other liquid-like effects -- from abstract 'etchings' to amazing organic flows.

Add Fluid Dynamics. Easily
create custom water drops and other
dynamic fluid effects that are more
attractive than standard wave effects.

Animate and Flow. Quickly
form amazing smooth liquid looks and
molten effects that ebb and flow over
time.

Aim At Your Subject. Easily
position the flowing effect wherever
desired within your images, such as
where your subject is located.

Invigorate Backgrounds.
Use FlowTexture to improve/freshen
stock clips in your collection for use in
new projects.

Create Depth Interest.
Subtlely deform and texture your
images in unconventional but realistic
ways to add visual interest.

Energize Stills/Titles. Use
FlowTexture to easily provide realistic
flex and change to still-image clips and
titles.

Match Your Content. Use
the unique Mixer tool to build waves or
distortions shaped like your clip's
content.

Enjoy Full Creative
Control. Control reflections,
lighting, softness, and other visual
qualities to enhance the effect's realism.

Deform with Spices. Base
the wave/distortion geometry on any
one of hundreds of Pixelan top-rated
'spices'.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

With powerful bezier keyframing, you can smoothly vary individual aspects of the FlowTexture effect during your clip, leading to incredibly dynamic
distortions.

FlowTexture Tutorial
FlowTexture Controls In Detail

Next page
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FlowTexture 2 Tutorial    Features Controls In Detail

Apply FlowTexture to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start
> Program Files > Pixelan > CreativEase menu.) After the FlowTexture window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the FlowTexture window to
select a saved setting, which will instantly configure ALL CONTROLS
into a cool effect. Several subfolders are included, organized by style.
Single-click any saved setting to quickly preview and compare it with
others. Double-click your final choice.

.

Click any light-bulb in FlowTexture to choose a preset, which will
instantly configure controls ONLY IN THAT SECTION into a powerful
combination. Keep in mind you can do this while the preview plays.
Presets are a great way to QUICKLY build USEFUL effects from scratch,
or to modify a saved setting. Try a few -- THOUSANDS of combinations
are provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of FlowTexture can be most
easily accessed in four steps:

STEP 1. Select the displacement geometry. FlowTexture uses the luminance of your clip's image or the luminance of a selected spice file (or a
variable mix of both) as the basis for displacement. To select from hundreds of available spice geometries (instead of using the default Elliptic1 C spice
file), click the Choose Spice File button at the center of the FlowTexture window. (For more details about this button and related controls, click here.) To
instead use the clip's luminance to form the displacement, set the Mixer slider to 100% at the bottom of the Displacement section. To mix the spice
geometry AND your clip's luminance, adjust the Mixer to an intermediate value, such as 50%. Experiment -- the Mixer is one of FlowTexture's most unique
and powerful controls. Keyframing the Mixer slider can lead to incredible flowing distortion effects. If you prefer a static (constant) distortion instead of a
flowing effect, right-click the green Keyframe light button next to the Progress slider to clear the default keyframing of the control.

Original clip Oval spice waves Mixer = 20 Mixer = 50 Mixer = 100

Your adjustments will appear instantly in the built-in FlowTexture preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will appear real-time
in the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

Depending on FlowTexture settings, noise along your image's edge may be emphasized. To avoid that, increase the Crop frame edge by value. Or apply our
powerful CleanCrop effect, if available to you.

STEP2. Fine-tune the displacement. Generally, you should first set the Waves slider (overall number of waves) and the Spread slider (distance
between waves). Then fine-tune further by adjusting the Height slider (overall refraction strength). Additional sliders provide more subtle fine-tuning. The

Ramping slider moves the maximum wave height from the inner wave toward the outer wave. The Rotation slider controls the refraction direction. And
the Softness slider blurs the distortion to create a more liquid-like look. All of these controls are keyframable to create wonderful evolving effects.

STEP3. Adjust the lighting (if desired). Depending on the look you desire, controls in the Light pane of FlowTexture can add further realism.
Intensity adjusts the light's power and Angle sets its direction. The Softness slider controls light/shadow details independent of the Displacement >
Softness slider. Use the Blend menu to make the light brighter/harsher if desired.

STEP4. Add texture to the effect (if desired). Click the Texture tab to access additional enhancements to consider. If you have our SpiceMASTER
2.x plug-in, the Texture controls here are similar. They provide variably-sized organic particle texturing to the effect. Many useful presets are provided
(click the light-bulb button), but to experiment further first adjust the Amount slider to set a desired strength. X Size and Y Size control the texture's size.
Density sets the extent of texturing, and activating the Motion slider will put the texture into random motion. As mentioned above, all of these controls are
keyframable to vary the texture enhancement during your clip.

After creating a desired FlowTexture effect, apply it by clicking the green "check mark" button in the lower right corner of the FlowTexture
window. Click here for more applying tips.

For more details and tips, click any link below:

FlowTexure Features
FlowTexture Controls In Detail

Next page
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To access useful presets per section, click the "light-bulb" button at the top-right of the Displacement, Light, or Texture sections.

Spice/Position

In the center of the FlowTexture window are the Choose Spice File button and related controls for positioning and modifying a spice file. Choose from lots
of Pixelan's top-rated, industry-standard "spices" to form the basic geometry of FlowTexture's displacement effect. If you also have our SpiceMASTER
plug-in, the controls work identically. Click here for more details.

Displacement
Seven sliders determine the basic character of the displacement effect. To vary the effect over time, keyframe any of the sliders.

Progress -- Sets the progress of the effect, typically keyframed from 0% to 100%. Note that 0% and 100% are identical, which is handy for creating a
FlowTexture effect that smoothly grows and then recedes during the clip.

Height -- Determines the "refraction strength" -- how much the image is distorted by the displacement waves.
Waves -- Sets the number of waves radiating from the displaced edge. The slider can range from 0.0 to 10.0 waves (up to 100.0 can be entered in its text
box), but for most effects values below 3.0 or 4.0 will be ideal.
Softness -- Can significantly smooth the wave results, especially in fine-textured displacements. And reduce potential banding in very simple spice
geometries. An important control for creating realistic waves.
Spread -- Sets the relative distance between waves. The slider can range 0.0 to 1.0, but up to 10.0 can be entered in its text box.

Ramping -- Higher values move the maximum wave point from the inner wave toward the outer wave. The slider ranges from 0.0 to 1.0.
Rotation -- Controls the refraction direction.

Light

This section determine the character of the simulated light on the waves.

Intensity --Sets the strength of the simulated light on the waves, from 0% to 100%.
Softness -- Controls light/shadow details independent of the displacement detail set by the Displacement > Softness slider.
Crop frame edge by -- Depending on FlowTexture settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase
this value. Or apply our powerful CleanCrop effect, if available to you.
Angle -- Sets the angle of the simulated light, from 0 degrees (image right) rotating counter-clockwise to 360 degrees (return to image right).

Blend -- In addition to the Normal light blending, Add and Multiply are available for harsher light looks.

Mixer -- Use the Mixer slider to mix the luminance of the selected spice file and the luminance of the image as the basis of the displacement effect.
Invert Mixer -- Inverts the image's luminance to provide a variation.

Texture
This section can add variably-sized organic texturing to the displacement effect.

Amount -- Determines the intensity of the texture.
X Size and Y Size --These sliders stretch the texture horizontally or vertically. Values range from 1 (single pixel) to 100 (frame width or height). This
enables you to create random streak effects (increase one slider much more than the other), large particles (increase both sliders, but stay below the 100
maximum), weaves, and other cool textures. Several presets show the creative possibilities.
Density -- Higher values reduce the density of the texture elements.
Motion -- Progressively adds random movement/animation to the texture elements during the effect.

For more details and tips, click any link below:

FlowTexture Features
FlowTexture Tutorial
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Standard noise plug-ins are all similar -- not very customizable and with only limited usefulness for video. At the other end of the spectrum are third-party
film-grain plug-ins which tend to be hard-to-learn, single-purpose and relatively expensive. GrainPlus is an affordable, versatile, easy-to-use alternative to
both. It gives you the power to:

Add Filmic Grain. Apply
subtle luminance-based grain to
emulate contemporary film. This is very
different than just lightly applying
noise, as in standard effects.

Synergize With Spices.
Use Pixelan 'spices' to easily mask the
grain/noise effect to only where you
want it within the image, such as
specific words in titles.

Customize The Look.
Quickly form and compare hundreds of
creative variations of grain/noise effects
-- great for video as well as
titles/logos/graphics.

Mutate Bigger. Turn noise into
other amorphous objects in your scene,
located wherever you desire.
Independently adjust strength, height,
width, softness, and color.

Maintain Brightness. Apply
grain/noise without changing the
image's brightness (unlike usual noise
effects) to keep your clip sequence
consistent.

Change Randomly.
Experiment with random luminance/hue
changes and other abstract time-based

effects. Then blend the effect with your
source clip.

Streak & Scratch. Add film
scratches, streaks, single-color noise
tints, and other creative noise variations
-- all easily customizable.

Age Your Footage. Scratch
and decay your footage to emulate old
film looks.

Buzz & Flash. Create visual
buzzing, roving lights/flashes, and

dynamic weaving patterns. Work in
different color spaces (RGB, HSV, HLS,
YUV and XYZ) to further expand the
range of effects.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all GrainPlus controls are bezier keyframable, you can smoothly vary individual aspects of the effect during your clip. With the powerful
Mixer control, you can also use a clip's luminance to define the effect areas, a very easy way to add grain to light or dark regions, for example.

GrainPlus Tutorial

GrainPlus Controls In Detail

Next page
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Apply GrainPlus to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start >
Program Files > Pixelan > CreativEase menu.) After the GrainPlus window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the GrainPlus window to select a
saved setting, which will instantly configure ALL CONTROLS into a cool
effect. (If GrainPlus's Saved Settings folder does not appear, navigate to
it.) Several subfolders are included, organized by style. Single-click a
saved setting to quickly preview and compare it with others. Double-click
your final choice.

.

Click any light-bulb in GrainPlus to choose a preset, which will instantly
configure controls ONLY IN THAT SECTION into a powerful combination.
Keep in mind you can do this while the preview plays. Presets are a great
way to QUICKLY build USEFUL effects from scratch, or to modify a saved
setting. Try a few -- THOUSANDS of combinations are provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of GrainPlus can be most
easily accessed in three steps:

STEP 1. Set the grain. First work with the Location and Strength controls, plus the three checkbox options at the bottom of the Grain section. When
the grain has the basic look you desire, next adjust Density and X Size/Y Size sliders. Setting one or both Size sliders to high values (but less than 100), for
example, can create cool horizontal/vertical streaks or large particles. The Density slider increases the quantity of grain particles in the image. The Motion
slider puts the grain into random motion during the clip.

Original (100% crop) Strength = 10 Strength = 20 Y increased Density decreased

 Your adjustments will appear instantly in the built-in GrainPlus preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will appear real-time in
the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

STEP 2. Enhance further with cool Extras. The Channels controls give you the flexibility to adjust the grain/noise in each color channel
individually. This makes it easy to set a desired color of monochromatic grain/noise, or to balance a color noise mix as desired. Working in other color
spaces of the Model menu further expand the possible colors and looks. For example, you can apply noise only to the S (saturation) channel of the HSV or
HLS color model to produce a desaturated or over-saturated grain instead of typical noise. For more extreme effects, experiment with YUV and XYZ
models.

Also available in the Extras section is a Blend menu. Nine compositing options produce a wide range of blends between the GrainPlus effect and the clip's
source image. The options are similar to blending modes found in programs such as Adobe Photoshop. To set the strength of the chosen Blend option,
adjust the Amount slider. Higher values show more of the clip's source image. To vary the strength during the effect, keyframeAmount.

Unblended grain 50% Normal 100% Lighten 100% Hard Light 100% Color Dodge

STEP 3. Limit or animate the effect area with a Pixelan spice. GrainPlus utilizes the soft/organic power of Pixelan spices (derived from our
popular SpiceMASTER plug-in) to geometrically mask where the effect (created from other GrainPlus controls) will appear within the frame. Click the
Spice tab to reveal spice controls to be used together with the Choose Spice File button and related settings in the center of the GrainPlus window.

You could have the GrainPlus effect appear only where your subject is rather than over the entire image, for example, or keep the GrainPlus effect in outer
areas to frame your subject. By keyframing the Position control, you can even have the effect area track your subject's movement. By keyframing the
Progress slider with an Iris spice, for example, you could have the grain effect flow from your subject organically outward to the frame edge. Or wash the
grain effect across the screen. (If you are familiar with our SpiceMASTER plug-in, Progress is just like Completion in SpiceMASTER.)

To use the clip's luminance (instead of a spice file's luminance) to limit where the GrainPlus effect appears within the image, set the Mixer slider to 100%
at the bottom of the Spice section. To mix the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate value, such as 50%.
Experiment -- the Mixer is one of GrainPlus's most unique controls. Keyframing the Mixer slider can lead to unique grain/noise flows within your clip!

After creating a desired GrainPlus effect, apply it by clicking the green "check mark" button in the lower right corner of the GrainPlus
window. Click here for more applying tips.

For more details and tips, click any link below:

GrainPlus Features
GrainPlus Controls In Detail

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts
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To access useful presets per section, click the "light-bulb" button at the top-right of the Grain, Channels, or Spice Effect sections.

Grain
Six controls in the Grain section determine its basic character:
Location -- Choose from these options to create uniformly distributed noise or to concentrate more noise in light or dark areas of your clip.
Strength -- Determines the intensity of the noise.
X Size and Y Size --These sliders stretch the grain/noise horizontally or vertically. Values range from 1 (single pixel) to 100 (frame width or height). This
enables you to create random streak effects (increase one slider much more than the other), large particles (increase both sliders, but stay below the 100
maximum), old film looks (increase Y Size only, then increase Density to provide random occasional film scratches), weaves, and other cool textures.
Several presets show the creative possibilities.
Density -- Lower values decrease the density of the grain/noise elements.
Motion -- Progressively adds random movement/animation to the grain/noise during the effect.

Three checkbox options can modify Grain:

Color noise -- Turn on to create color noise instead of monochromatic noise.

Light & dark grain -- Adds light AND dark noise particles instead of only light OR dark ones.

Invert-- Inverts the grain/noise if Light & dark grain is ON; otherwise it switches light and dark grain/noise particles.

Channels
Model -- Allows you to add grain/noise in different color spaces. RGB (the default), HSV, HLS, YUV and XYZ are available. Working in other color spaces
can dramatically change the noise's look. For example, adjusting the S (saturation) channel in the HSV or HLS model creates a desaturated or
over-saturated grain instead of typical noise. For more extreme effects, experiment with YUV and XYZ models.
R, G, B -- Three sliders are available to control the grain/noise intensity in each color channel. For example, you can set the color for monochromatic
noise. Note: Dark noise particles visually appear in an opposite color to the light ones. If you add noise in Blue channel, for example, the light noise
particles will appear blue, but the dark ones will be yellow.

Blend
Nine compositing options produce a wide range of blends between the GrainPlus effect and the clip's source image. The options are similar to blending
modes found in programs such as Adobe Photoshop. To set the strength of the chosen Blend option, adjust the Amount slider. Higher values show more of
the clip's source image. To vary the strength during the effect, keyframeAmount.
Normal -- Blends details from the source image uniformly throughout the image, like a video dissolve. This is a handy way to make a GrainPlus effect
uniformly more subtle.
Lighten -- Only blends in pixels from the source image that are lighter than the GrainPlus effect.
Darken -- Only blends in pixels from the source image that are darker than the GrainPlus effect.
Add -- Combines color values in the effect and source image, creating lighter colors. Black pixels remain unchanged and white pixels remain white.
Screen -- Lightens/brightens all colors in the GrainPlus effect. Black pixels remain unchanged, however, and white pixels remain white.
Hard Light -- Selectively screens colors to produce a result that appears like a harsh lighting on the effect image.
Vivid Light -- Similar to Hard Light, but increases contrast in colors that are lighter than 50% gray. It therefore usually produces stronger colors than
Hard Light.
Linear Light -- Similar to Hard Light, but further brightens colors that are lighter than 50% gray. It therefore usually produces stronger colors than both
Hard Light and Vivid Light.
Color Dodge -- The lighter the effect color, the brighter the resulting color with this option turned on. Black pixels remain unchanged, however, and white
pixels usually remain white.

Spice Effect
Like our popular SpiceMASTER plug-in, GrainPlus utilizes our top-rated, industry-standard "spices" to generate fresh effects -- in this case, to
geometrically 'mask' where the GrainPlus effect (established from the other sections described above) will appear within the frame. Adjust Spice Effect
settings together with the Spice/Position controls described below.

Effect -- An on/off control for the spice effect.

Progress -- Based on the selected spice file, this slider set the area where the GrainPlus effect will be visible. At 0% the effect will appear where blackest
pixels reside (in the spice file's grayscale image, not your content). At higher values, the effect will be visible where lighter grays reside in the spice file's
image, and at 100% where the whitest pixels exist in the spice file's image.

Softness -- Higher values soften the boundary between the GrainPlus effect and no effect areas -- as determined by the selected spice file's geometry.

Effect only in soft area-- Use this option to limit the GrainPlus effect only to the Softness area (set by the above control). Increase Softness to widen the
effect area. Adjust the Progress slider to determine where the effect area appears.

Mixer -- This unique control blends the spice and source clip's luminance to create a mask shape that is determined by your clip. At 100%, purely the
SOURCE clip's luminance is used as the effect mask. To mix using the spice geometry AND your clip's luminance, adjust the Mixer to an intermediate
value, such as 50%. Experiment -- the Mixer is one of GrainPlus's most unique and powerful controls. NOTE: Progress must not equal 0 or 100 for the

Mixer to have visual impact. Invert Mixer-- Turn on this option to invert where the Mixer luminance mask forms in the source clip.

Spice/Position
In the center of the GrainPlus window are the Choose Spice File button and related controls for positioning and modifying the Spice Effect. If you also have
our SpiceMASTER plug-in, the controls work identically. Click here for more details.

For more details and tips, click any link below:
GrainPlus Features
GrainPlus Tutorial

Next page
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Spatter looks have been around for years, but are not compelling or useful because their grain tends to randomly appear UNIFORMLY over the ENTIRE
image. Ugh. In contrast, SpatterFlex gives you wonderful Pixelan 'spices', our trademark adjustable softness, our industry-unqiue Mixer tool, and many
other intuitive controls to give you complete creative control over the spatter look. That transforms spattering into a sensitive, organic, artistic tool for
your video images -- as well as terrific distortions for titles and graphics.

Enjoy the Organic.
SpatterFlex's organic, variable, flowing
visual quality is far more compelling
than standard texture effects or
overlays.

Flex Titles/Graphics.
Randomly distort titles, logos, graphics,
etc. easily without having to detour into
motion graphics software.

Add Artistry. Break out of the
box of cliche "art" effects bundled in
most editing programs, by utilizing
SpatterFlex's many controls to create
attractive new looks.

Enhance Sensitively.
Enhance your title fonts with sensitive
texture/grain that is not applied
uniformly, creating attractive new (yet
readable) looks.

Flex the Particles. No longer
are you stuck with a few particle/grain
looks. Instead, flex the shapes over
time, emphasizing horizontal or vertical
if desired.

Be Creatively Free. Powerful
but easy-to use bezier keyframing and
intuitive controls allow you to focus on
creativity instead of reading a thick
manual.

Control WHERE. Use the
amazing power of Pixelan spices and
the industry-unique Mixer tool to easily
set where the effect will appear, to
choose what to accent.

Adjust the Density. Reduce
the grain density in SpatterFlex to
create flying debris and other particle
swarms that fly over your subject. Cool!

Distort Your Subjects. Use
very large "invisible" particles to form
organic, random distortions -- a fresh
look compared to the usual wave
effects.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all SpatterFlex controls are bezier keyframable, you can smoothly vary individual aspects of the effect over time to create fantastic flowing
effects!

SpatterFlex Tutorial
SpatterFlex Controls In Detail

Next page
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Apply SpatterFlex to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start
> Program Files > Pixelan > CreativEase menu.) After the SpatterFlex window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the SpatterFlex window to select
a saved setting, which will instantly configure ALL CONTROLS into a
cool effect. Several subfolders are included, organized by style.
Single-click any saved setting to quickly preview and compare it with
others. Double-click your final choice.

.

Click any light-bulb in SpatterFlex to choose a preset, which will
instantly configure controls ONLY IN THAT SECTION into a powerful
combination. Keep in mind you can do this while the preview plays.
Presets are a great way to QUICKLY build USEFUL effects from scratch,
or to modify a saved setting. Try a few -- more than FOUR THOUSAND
combinations are provided!

OR create a custom effect by manually adjusting. For this latter approach, generally the power of SpatterFlex is most easily
accessed in three steps:

STEP 1. Set the general location and amount of spatter. Use the Type and Amount controls in the Main section of SpatterFlex, together with the
Spice and Mixer controls in the Extras section. (Clicking the Dual Pane button in the top right of the SpatterFlex window can help, so you can see Main
and Extras sections side-by-side.)

SpatterFlex uses the luminance of your clip's image or the luminance of a selected spice file (or a variable mix of both) as the basis for where patter
particles will appear. To select from hundreds of available spice geometries (instead of using the default Elliptic1 C spice file), click the Choose Spice File
button at the center of the SpatterFlex window. (For more details about this button and related controls, click here.)

To instead use the clip's luminance to form where spatter particles appear, set the Mixer slider in the Extras section of SpatterFlex to 100%. To mix the
spice geometry AND your clip's luminance, adjust the Mixer to an intermediate value, such as 50%. Experiment -- the Mixer is one of OrganiBlur's most
unique and powerful controls. Keyframing the Mixer slider can lead to incredible organic flowing blur effects.

Your adjustments will appear instantly in the built-in SpatterFlex preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will instead appear
real-time in the Vegas preview.) Note you can even loop-play the effect while making adjustments. Click here for more preview tips.

 STEP 2. Adjust the spatter size, softness, and motion. With Progress at its default 50%, adjust X Size and Y Size sliders in the Grain section.
Turning on the Hard particles check box can create a more varigated look. To change the spatter to more of a molten effect, use the Softness slider. To set
spatter particles in motion during the clip, which is almost always desirable for a more realistic look, increase the Motion slider.

STEP 3. Fine-tune the effect. In the Main section, Type > One-way tones down the overall spatter effect. Spread affects how wide the spatter
appears from its origin. Ramping controls where within the effect spatter will appear strongest. Angle can add a various OrganiBlur-like swirling blurs
behind the spatter look.

Depending on SpatterFlex settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, in the Extras section increase the

Crop frame edge by value. Or apply our powerful CleanCrop effect, if available to you.

After creating a desired SpatterFlex effect, apply it by clicking the green "check mark" button in the lower right corner of the SpatterFlex
window. Click here for more applying tips.

For more details and tips, click any link below:

SpatterFlex Features
SpatterFlex Controls In Detail

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
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To access useful presets per section, click the "light-bulb" button at the top-right of the Spatter, Grain or Extras section.

NOTE: Words cannot do justice to the power of several of the controls below and their synergy. Please explore the available presets, as mentioned above,
and experiment with modifying control values to create truly unique effects.

Spatter

Progress -- Progressively sets the extent of the spatter established by other controls. Maximum is 50%. No spatter appears at 0% and 100%. Thus the
slider is designed, when keyframed from 0% to 100%, to gradually increase the effect to a maximum and then decrease back to no effect during a clip. To
just set a static spatter effect during the entire clip, there is no need to keyframe -- just experiment with the slider to determine its best constant value for
your desired effect.
Type -- Two-way spreads the spatter effect in two opposite directions from any origin point; One-way in one direction. Generally, Two-way creates a
stronger effect.
Amount -- Controls the overall spatter power.
Spread -- Specifies the size of the spatter area, as determined by the chosen spice file and/or Mixer value (see below). Values less than 1.0 spatter only
part of the image. High values produce a uniform spatter over the entire image.
Angle -- The underlying blur under the spatter look will follow the luminance gradient's direction unless you use this control to rotate the direction.
Keyframing it can easily create swirling OrganiBlur-like effects underneath the spatter particles.
Ramping -- At its 50% default value, the spatter power has its maximum at the center of the spatter area and decreases toward the edges. Other values
move the spatter maximum elsewhere within the spattered area. 0% moves the maximum to the beginning of the spatter area; 100% to the end.

Grain

X Size and Y Size --These sliders stretch the spatter particles horizontally or vertically. Values range from 1 (single pixel) to 100 (frame width or height).
Several presets show the creative possibilities.
Softness -- Determines the egde softness of the spatter particles. High values can create molten looks.
Density -- Lower values decrease the density of the spatter elements.
Motion -- Progressively adds random movement/animation to the spatter during the effect. Highly desireable for a more compelling look.

Hard particles -- Turn on this checkbox to create a more varigated spatter look.

Extras

Mask -- Like our popular SpiceMASTER plug-in, when the default Spice File choice is active, SpatterFlex utilizes our top-rated, industry-standard "spices"
to generate where the spatter effect will appear within the image. Use the Spice/Position controls described at the bottom of this page to adjust many

aspects of the spice file. Or, you can base the SpatterFlex effect on the Image's Luminance, which creates an entirely different/unique effect basis that
relates directly to your image content.
Softness -- Alters the spice/luminance pixels used by SpatterFlex, especially when the Mixer is activated.

Mixer -- This unique control blends the spice and source clip's luminance to the spatter look will appear within the clip's image. At 100%, purely the
SOURCE clip's luminance is used as the basis for the spatter. To mix using the spice geometry AND your clip's luminance, adjust the Mixer to an
intermediate value, such as 50%. Experiment -- the Mixer is one of SpatterFlex's most unique and powerful controls. NOTE: Progress must not equal 0 or
100 for the Mixer to have visual impact.

Invert Mixer -- Turn on this option to invert where the Mixer-based blur forms in the source clip.

Crop frame edge by -- Depending on SpatterFlex settings, edge fringing or noise along your image's edge may be emphasized. To avoid that, increase
this value. Or apply our powerful CleanCrop effect, if available to you.

Spice/Position

In the center of the SpatterFlex window are the Choose Spice File button and related controls for positioning and modifying the effect when it is based on
a spice file (thus Input > Spice File is chosen). If you also have our SpiceMASTER plug-in, the controls work identically. Click here for more details.

For more details and tips, click any link below:

SpatterFlex Features
SpatterFlex Tutorial

Next page

Keyframing an Effect
Saving Favorite Effects
How to Choose a Spice File
Preferences
Keyboard Shortcuts

34



Basic Steps Contents

StepMotion 2 Features    Tutorial Controls In Detail

StepMotion is a simple but powerful plug-in for image ghosting, trailing, and other time-delay effects which are especially useful in high-motion footage.
Unlike standard "echo" or "ghosting" effects that simply combine frames from two or more instances during a clip, StepMotion can produce a more
attractive, progressively-faded visual echo to motion in a scene. StepMotion allows you to:

Enjoy Independence.
Independently control/vary the delay
and intensity of the effect, from bold
"time echos" to very soft "time blurs."

Go Dark. Adjust StepMotion to
only emphasize dark ghosting when
desired for a unique effect.

Look Dreamy. Slow down your
clips and apply StepMotion to create
terrific dream looks -- for special
segments, wedding or religious videos,
etc.

Trail Titles/Graphics. Add
beautiful dissolving motion trails to
ttitles, logos, and graphics that are
more attractive than standard echo
effects.

Emphasize Light.
Independently emphasize light elements
while not ghosting dark areas.

Play with Motion. Use
StepMotion to softly hint at, or slowly
reveal/hide, moving objects within a
scene.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since all StepMotion controls are bezier keyframable, you can smoothly vary individual aspects of the effect during a clip, leading to wonderfully
evolving imagery.

StepMotion Tutorial
StepMotion Controls In Detail

Next page

35

http://www.pixelan.com/images/ce/featuresm1-large.htm
http://www.pixelan.com/images/ce/featuresm4-large.htm
http://www.pixelan.com/images/ce/featuresm2-large.htm
http://www.pixelan.com/images/ce/featuresm5-large.htm
http://www.pixelan.com/images/ce/featuresm3-large.htm
http://www.pixelan.com/images/ce/featuresm6-large.htm
http://www.pixelan.com/ce/movies.htm


Basic Steps Contents

StepMotion 2 Tutorial    Features Controls In Detail

Apply StepMotion to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start
> Program Files > Pixelan > CreativEase menu.) After the StepMotion window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the StepMotion window to select
a saved setting, which will instantly configure ALL CONTROLS into a
cool effect. (If StepMotion's Saved Settings folder does not appear,
navigate to it.) Several subfolders are included, organized by style.
Double-click your choice.

.

Click the light-bulb in StepMotion to choose a preset, which for
StepMotion are identical to saved settings. The main advantage in
StepMotion of choosing a preset instead of a saved setting is you can
switch presets while the preview plays continuously.

OR create a custom effect by manually adjusting. For this latter approach, generally the power of StepMotion can be most
easily accessed in two steps:

STEP 1. Adjust the Delay times. Higher values create longer delay times. For ghosting and soft dream-like effects set Light and Dark to the same
value. To instead create dark or light object trails behind the moving subject, set Light and Dark to different values. Long delay times can produce
interesting effects. You can make some objects slowly appear and/or disappear, or even completely remove moving objects from the background. For
example, you can modify a high-speed sunrise clip to be without people/cars flashing by and without wind-blown trees jerking.

STEP 2. Adjust the Reaction sliders. While Delay sliders vary the delay time (thus set the ghosting/trails length), the Reaction sliders control the
trail's style/visibility. Negative values add blur to moving elements in the scene; positive values produce contrast trails that visually enhance the moving
objects.

Sony Vegas IMPORTANT NOTE: Clicking in the Sony Vegas (or Vegas Movie Studio) timeline to preview individual frames of a StepMotion effect may
not show accurately your final output. It is due to a limitation in Vegas regarding time-based effects. For best preview results, temporarily disable RAM
preview in Vegas and then preview in Vegas by playing the ENTIRE clip that has the StepMotion effect.

After creating a desired StepMotion effect, apply it by clicking the green "check mark" button in the lower right corner of the StepMotion
window. Click here for more applying tips.

For more details and tips, click any link below:

StepMotion Features
StepMotion Controls In Detail
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To access useful presets, click the "light-bulb" button in StepMotion.

Delay

Light/Dark -- These sliders allow you to individually control whether the ghosting develops from darker or lighter areas (or both). The higher the value,
the more the ghosting will appear. To vary these values during the effect, keyframe either or both sliders.

Reaction

Light/Dark -- These sliders control whether the ghosting is dark or light (or both). Values range from -1.0 to 1.0. Positive values tend to posterize the
image (limit the color range); negative values tend to create dreamy, ephemeral looks. To vary reaction during the effect, keyframe either or both sliders.

** A good way to approach these controls is to compare the four combinations of extreme values (-1,-1; -1,1; 1,-1 and 1,1) with your particular visual
event, then moderate the values as desired.

** In the Sony Vegas/Vegas Movie Studio version, a Fields check box is available to optionally process the StepMotion effect per field rather than per
frame.

For more details and tips, click any link below:

StepMotion Features
StepMotion Tutorial
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Standard "posterize time" effects output a lower frame rate to create a simple stop-action 'stutter' look to motion in a scene. Standard "echo" effects
provide multiple "trailing" frame images but do not dissolve those attractively or flexibly. StepTime goes further than either, giving you the ability to
easily:

Blend Stop-Action. Freeze
frames per a desired interval, then
adjustably blend the action in-between,
leading to a more attractive/unique
stop-action effect.

Adjust the Source. Adjustably
blend the effect with your source clip to
further customize the effect.

Echo Only Light or Dark.
Choose to visually echo only light or
dark pixels in your image, if desired, for
a more sophisticated look.

Add a Hot Strobe. (Sony
Vegas /Vegas Movie Studio version
only) Easily apply an adjustable strobe
flash (any color) to the stop-action effect
if desired.

Control the Dissolving.
Get independent control over the
stop-action timing AND the amount of
dissolve/blending of in-between frames.

Strobe Transparent. (Sony
Vegas /Vegas Movie Studio version
only)Strobe to show lower tracks clips
instead of a flash -- a very cool effect.

****** To view LARGER, click on any image ******
****** To view a cool movie of this effect, click here ******

Since virtually all StepTime controls are bezier keyframable, you can smoothly vary individual aspects of the effect during a clip, leading to terrific
evolving imagery.

StepTime Tutorial
StepTime Controls In Detail
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Apply StepTime to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start >
Program Files > Pixelan > CreativEase menu.) After the StepTime window appears, either:

Choose a pre-made effect. Choose a saved setting or one or more section presets to INSTANTLY form a particular look.

Click this button in the black bar area of the StepTime window to select a
saved setting, which will instantly configure ALl CONTROLS into a cool
effect. (If StepTime's Saved Settings folder does not appear, navigate to
it.) Several subfolders are included, organized by style. Double-click your
choice.

.

Click the light-bulb in StepTime to choose a preset, which for StepTime
are identical to saved settings. The main advantage in StepTime of
choosing a preset instead of a saved setting is you can switch presets
while the preview plays continuously.

OR create a custom effect by manually adjusting. For this latter approach, generally the power of StepTime can be most easily
accessed in two or three steps:

STEP 1. Adjust the effect's tempo. You may find it easiest to set the Tempo value while the effect's preview plays.

STEP 2. Fine-tune the effect's style. Adjust the Style and Blend menus (Strength and Mix sliders in the Sony version) and Hardness slider as
desired. Blending the source video and the StepTime effect produces more of a ghosting/echo look rather than a low frame rate or stop-action effect.

STEP 3.  (Sony Vegas/Vegas Movie Studio version only) Add a strobe effect, if desired. Enter a Strobe Frames value to activate the strobe
effect. To create 3 frames of strobe and 10 frames of image repetitively, for example, you would set Strobe Frames to 3 and Tempo to 10. Use the Color
palette/eyedropper to choose a strobe frame color, if black is not desired. To reveal overlapping lower content in strobe frames instead of a color, turn on
the Key check box. To only apply a strobe effect and no other StepTime look, turn on the Strobe only check box.

NOTE: A clip's mask and any previously applied effects are ignored when StepTime is applied. The workaround is to pre-render the clip's other effects
before applying StepTime.

Sony Vegas IMPORTANT NOTE: Clicking in the Sony Vegas (or Vegas Movie Studio) timeline to preview individual frames of a StepTime effect may not
show accurately your final output. It is due to a limitation in Vegas regarding time-based effects. For best preview results, temporarily disable RAM
preview in Vegas and then preview in Vegas by playing the ENTIRE clip that has the StepTime effect.

After creating a desired StepTime effect, apply it by clicking the green "check mark" button in the lower right corner of the StepTime
window. Click here for more applying tips.

For more details and tips, click any link below:

StepTime Features
StepTime Controls In Detail
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To access useful presets, click the "light-bulb" button in StepTime.

Below are StepTime controls in all versions EXCEPT the Sony version (see the next section below).

Style -- Selects the style of the stop-action effect. Stop-Action shows a 'classic' stop-action look -- frozen frames appearing periodically. Freeze Behind
shows stop-action frames that dissolve behind the video action, much like a progressive "echo" look. Freeze Ahead creates the inverse effect: video action
plays into a frozen frame that appears ahead.
Blend -- Controls the blending that occurs between full-strength frozen frames. Standard produces a traditional dissolve. Darken accents dark object area;
Lighten accents light object areas.
Tempo -- Sets how often a frozen frame will appear -- in number of frames. A maximum value of 30, for example, means that a full-strength frozen frame
will appear once per second in a 30 frames-per-second clip.
Hardness --Determines the strength of StepTime's dissolve between full-strength frames. From 0% to 100% is possible. Low values retain the dissolve.
100% creates a "hard" look -- only full-strength frames appear with nothing shown between.
Source -- Higher values show more of the source video blended with the effect, thus this is another way to moderate the effect's visual strength.

To vary any of the above slider/color controls during the effect,keyframe one or more of them.

ONLY in the Sony Vegas/Vegas Movie Studio version are the following controls:
Strength -- Sets the intensity of the entire StepTime effect, from 0% to 100%. Intermediate values can create interesting pulsating effects, as shown by
several presets.
Mix --Determines the dissolve style that StepTime creates between full-strength frames. 0% is a traditional cross-dissolve -- the first full-strength image
weakens as the second strengthens. 100% dissolves frozen frames behind the video action, like a progressive "echo" look. Intermediate values mix both
dissolves together.
Tempo -- Sets how often a frozen frame will appear -- in number of frames. A maximum value of 30, for example, means that a full-strength frozen frame
will appear once per second in a 30 frames-per-second clip.
Hardness -- Determines the strength of StepTime's dissolve between full-strength frames. From 0% to 100% is possible. Low values retain the dissolve.
100% creates a "hard" look -- only full-strength frames appear with nothing shown between.
Strobe -- Sets how many frames will appear as a strobe. To create 3 frames of strobe and 10 frames of image repetitively, for example, you would set
Strobe to 3 and Tempo to 10.
Color -- Changes the color of strobe frames from the default black. Use the eyedropper to select a color from anywhere on your screen, or the color palette
to choose via Windows.
Key -- Automatically keys out strobe frames to reveal overlapping events in lower tracks. Try it -- it's a great way to create new flash-image effects!
Strobe only -- Turn this on to only produce hard, full-strength strobe frames -- no stop-action dissolving between. It therefore overrides the Strength
slider.
Fields -- Turning on sets the Tempo Frames and Strobe Frames slider values to fields rather than frames.

To vary any of the above slider/color controls during the effect,keyframe one or more of them.

For more details and tips, click any link below:

StepTime Features
StepTime Tutorial
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CleanCrop Features     CleanCrop Tutorial
Cropping removes unwanted frame edge 'noise' in video clips, such as from tape-based camcorders. However, standard tools stretch/zoom the remaining
(inside) image out to the frame edge, introducing distortion and loss of sharpness. Or they cover up noise with a simple hard-edged color border, forcing
you to edit with a sometimes-inappropriate look to get clean images. Amazingly, over digital video's history, nothing has solved this well -- until CleanCrop!

CleanCrop retains the original image's clarity/sharpness by replacing noise with SIMILAR pixels as nearby source pixels, creating NATURAL-LOOKING
results. Detailed/textured areas continue to the edge, as do soft/solid color areas. CleanCrop also can SOFTLY BLEND the frame edge (corrected or not) to
any color or to show lower clip layers, either of which can be more appealing and useful than a hard-edged border.

This 648x480 clip has extensive noise & chromatic errors along the left edge, luminance errors along the bottom edge, and a subtle graying for one pixel
along the right edge. All typical problems with source video clips.

Standard built-in crop applied from a popular editing program, stretching the image to hide problems. Note the loss of sharpness throughout the clip.

CleanCrop's magic! Edge problems are seamlessly removed, no matter if there is detail or smoothness -- AND original sharpness/positioning is retained!

Next page
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CleanCrop Features (continued) CleanCrop Tutorial

CleanCrop also can pre-condition your clips to greatly improve the edge results of ANY OTHER video effects that rely on blurring, sharpening, or distortion
in some way.

CleanCrop Tutorial

Next page
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CleanCrop Tutorial    Features
Apply CleanCrop to a clip in your timeline, like any built-in video effect. (Don't know how? See the Please Read FIRST file in your Window's Start >
Program Files > Pixelan > CreativEase menu.) After the CleanCrop window appears, either:

Choose a pre-made effect. Choose a preset to INSTANTLY form a particular look.

Click the light-bulb in CleanCrop to choose a preset that will
instantly configure CleanCrop to a useful result. Presets even can
be chosen while the preview plays.

OR create a custom effect by manually adjusting. The first four submenus set the quantity of cropped pixels for each frame
edge. To quickly set all sides equally and simultaneously, turn on the Adjust all checkbox.

To adjust the appearance of replacement pixels, use the Mirror slider. That submenu determines the relative blending of mirrored "good" pixels to
linearly extended "good" pixels. Although the default of 50% is good for many images, some clips may require a different mix.

To replace cropped pixels with a soft blend to a chosen color, increase the Amount slider that is under the Color control. Click the eyedropper in the
Color control to choose a color from anywhere on-screen, such from your clip. Or use the standard Windows color palette to set a color.

To instead replace the color with lower clip content, turn on the Show lower clips check box. The Amount slider will then set the blending of lower
clip content to replacement pixels.

Your adjustments will appear instantly in the built-in CleanCrop preview. (In the Sony Vegas/Vegas Movie Studio version, the effect will appear real-time in
the Vegas preview.) You can even loop-play the effect while making adjustments. Click here for more preview tips.

After creating a desired CleanCrop effect, apply it by clicking the green "check mark" button in the lower right corner of the CleanCrop
window. Click here for more applying tips.

For more details and tips, click any link below:

CleanCrop Features

Next page

Saving Favorite Effects
Preferences
Keyboard Shortcuts

43



Keyframing Contents

Simple Keyframing
To set a CreativEase control to a new CONSTANT value, you do NOT need keyframes. Just drag the control's slider or enter a new value in its text box. To
VARY a control's value during an effect, however, use the simple technique below:

Simple Keyframing (varying a control LINEARLYduring an effect)
1. Go to the clip's FIRST frame. In all versions except the Sony version,Drag the CreativEase effect's preview scrub control all the way to the left, as
shown below. Other easy ways to do this areclicking the First Frame button under the preview, or entering "0:00"in the Current Time box to the left of the
preview buttons.

In the Sony version,  the above controls are not available since Vegas' real-time built-in preview is used. Instead, click the brown Keyframes button in the
lower left of any CreativEase effect window.

In the Keyframes window that will open, drag the blue vertical frame marker all the way left to the clip's first frame, as shown below.

2. Set a value for the effect's FIRST frame. In the example below, we have set the Pre-blur value of the PosterWise plug-in to 15 by dragging its slider.

3. Click the round keyframe button to the left of the control. This turns on keyframing for that control (as indicated by the button's light turning on and

the Keyframes window appearing if not already visible) and sets a keyframe at the first frame to the value (in this example, 15). The effect will therefore
start with that value.

4. Go to a different frame of the clip by dragging the blue vertical frame marker left or right in the Keyframes window. In all versions except the Sony

version, you can instead use the preview scrub control (shown below), click a preview button under the preview, or enter a frame's relative timecode in
the Current Time box to the left of the preview buttons. In the example below, we've moved to the clip's last frame.

In the Sony version ONLY, to match the blue vertical frame marker in the Keyframes graph of CreativEase to the Vegas timeline marker's position,

Alt-click in the Keyframes graph's background (or right-click there and choose Sync to Vegas timeline).

5. At the different frame, change the keyframed control's value by dragging the control's slider or entering a new value in its text box. For example,
say we've increased Pre-blur to 25 at the last frame of the effect. Between first and last frames, therefore, Pre-blur will smoothly increase linearly between
15 and 25. For example, the middle frame during the effect will automatically have a Pre-blur value of 20.

To set different values for other frames during the effect, repeat Steps 4-5 for any other frames. That's all!

The above process works for any control that is keyframable (has a round keyframe button to the left of the control). To learn advanced
keyframing, such as using bezier curve acceleration/deceleration to smoothly ramp up or down a control, see the next page.
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Advanced Keyframing

The powerful keyframer built into CreativEase effects can easily make sophisticated keyframe adjustments. You can adjust and
move keyframes in a graph, for example, using bezier curves to smoothly ramp up or down an effect quality. The keyframer is easy
to learn and intuitive. To access the keyframer, click the brown Keyframes button in the lower left of a CreativEase window.

A Keyframes graph window will then appear, as shown below.

The horizontal scale of the graph represents the clip's duration, from 0% to 100%. The vertical scale represents the control value.
Each keyframable control has its own keyframe graph. To see the graph for a control, click the round "light" that is
left of the control you want to keyframe. The light will turn on brightly to indicate keyframing is active for that control.

That control's graph will then appear in the Keyframes graph -- initially as a horizontal line to show (so far) a constant value.

To add a new keyframe, click anywhere on the graph line to create a new keyframe. (Or click the "+" Add Key button at the
top right of the Keyframes window.) Then drag the keyframe "dot" to a desired position. Drag it up, down, or sideways. As you
drag the keyframe, its coordinates will appear in the top left corner of the graph, and the effect's preview will instantly update.
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Advanced Keyframing (continued)

Note that if the Keyframes window is already open, you can drag the blue vertical playback marker (shown above at
approximately the 50% duration position) to go to wherever you want to preview or add a new keyframe. To drag it, drag its top
triangular head left or right.

How to Delete Keyframes

To delete one keyframe, right-click it in the Keyframes graph and choose Delete keyframe. Or click the keyframe if it is not
already active (it will appear brighter if active), then click the Delete Key (-) button at the top of the Keyframes window.

To freely experiment with keyframes and revert to an earlier keyframe profile, you can also use the Undo/Redo buttons (shown
below). More than 100 undo/redo's are available so you can easily experiment with different settings. To undo a change,
click the yellow Undo button (or tap  Ctrl-Z keys). To redo the change, click the adjacent green Redo button (or tap Ctrl-X keys).
If either is not available, the button will be dim.

To delete ALL keyframes for a control, right-click the control's round keyframe light and OK the dialog that will appear (if
"Confirm clearing/exiting" Preferences option is on). To delete ALL keyframes for a control AND revert to the control's
default value, right-click in the keyframe graph's gray background and choose Revert to default.

How to Accelerate/Decelerate a Keyframe

Now for powerful fun! Straight segments of a keyframe line represent a linear (constant) rate of change in an effect's value --
thus no acceleration or deceleration. To smoothly accelerate or decelerate an effect's quality, "curve" the keyframe line by
dragging a bezier curve handle attached to any active keyframe.

To decelerate over time, drag the keyframe's bezier handle to create an downward curved line, as shown below.

To accelerate a change in an effect's value, drag the keyframe's bezier handle to create an upward curved line.
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How to Move a Keyframe Precisely

Although dragging a keyframe in the Keyframes graph is the easiest way to position it, sometimes you may want more precision.
Use any of the following methods.

To move a keyframe only horizontally or vertically in the Keyframes graph, Shift-drag it. To fine-tune the position, click the
Zoom (+) button (shown below) to zoom into the graph and then drag as needed. (For more zoom techniques, click here.)

To precisely position an existing keyframe, right-click the keyframe in the graph and choose Enter coordinates. Then enter the
desired values as percentages (from 0% to 100%).

Note that the keyframe's Time position may not end up exactly as entered if there are not enough frames in the effect to
precisely match the percentage.

To match a keyframe's value (vertical height in the graph) with another keyframe, right-click the keyframe that has the
desired value, then choose Copy value. Then right-click the other keyframe and choose Paste value.
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Navigating in the Keyframes Graph

Jumping to a specific keyframe can be useful when several keyframes are clustered tightly together. Zooming the keyframe
graph is handy when you want to more precisely position a keyframe, or have several keyframes that are very close together.

How to Jump to a Specific Keyframe

To jump to a keyframe, just click on it in the Keyframes window. But among tightly clustered keyframes, sometimes that can be
difficult. Also, sometimes you may want to activate a keyframe without perhaps accidentally changing its position by clicking on
it. Here is an alternative: To select the next or previous keyframe, or first or last keyframe, click the corresponding button
that is above the Keyframes graph area. For example, to activate the next keyframe, click the Next Key button.

How to Zoom In/Out of the Keyframes Graph

Do any of the following. To zoom IN�
�horizontally toward the graph's center, click the Zoom In (+) button at the top left of the Keyframes graph. Repeat to zoom
in further, if desired.

�horizontally toward either end of the graph, drag inward either light blue tip of the Keyframes graph's horizontal scroll bar.
Likewise, to zoom in vertically to magnify the graph's top or bottom, drag inward either light blue tip of the vertical scroll
bar.

�vertically only, Shift-click the Zoom In (+) button. Shift-click the Zoom Out (-) button to vertically zoom out.

�vertically to the range where keyframes exist, right-click the graph's gray background, then choose Fit graph to keyframes.
This can help you to fine-tune values in relatively flat keyframe profiles.

�wherever you define, Alt-drag in the graph to define where you want to zoom. Or Alt-click the Zoom In (+) button (or
right-click the graph's gray background and choose Drag to zoom in), then drag to define where you want to zoom.

Next page

48



Keyframing Contents

Navigating in the Keyframes Graph (continued)

To scroll horizontally or vertically from where you zoomed, drag the gray background of the graph, or drag the center of
either keyframe scroll bar (or click their arrows). To bring the blue vertical playback marker into the zoomed region of a
graph, click in the numerical bar above the graph.

To zoom back OUT by 2X, click the Zoom Out (-) button. To instantly return the keyframe graph to show the entire
duration (0% to 100%), double-click the Zoom Out button.

Tips

** To jump to a different area of a zoomed graph, first double-click the Zoom Out (-) button to return to the graph's default
(full) view.

Then Alt-drag in the graph to define where you want to jump to.

** You can drag a keyframe horizontally beyond a zoomed graph area. Although the graph will not scroll horizontally as you drag,
you can use the coordinates reported in the top left corner of the graph to see your position. Or, use the graph's horizontal scroll
bar to reveal the target area before dragging.
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More Keyframing Tips

Below are additional handy tips that will enhance your keyframing.
** How to switch to a different keyframe graph
** How to copy and paste keyframing
** How to flip, invert, scale or move a keyframe line
** How to customize the Keyframes graph display
** How to move a bezier handle that is on top of a keyframe
** How to stay at a frame while adjusting keyframes elsewhere
** How to snap a keyframe to the vertical playback marker position
** How to make automatic bezier curve adjustments
** Understanding keyframe lights

** How to switch to a different keyframe graph
When keyframing several controls in a CreativEase effect, to switch to a particular control's graph just click the round keyframe
light at the left of the control. Or right-click the copper-colored Keyframes label in the Keyframes window, then choose the
desired control (as shown below).

** How to copy and paste keyframing
To copy and paste an entire keyframe line from one control to another, right-click in the Keyframes graph background and
choose Copy and/or Paste. Note that if the copied values do not fit within the parameters of the paste location, they will be
modified. To copy and paste only the value of a single keyframe, right-click a keyframe and choose Copy value, then choose Paste
value in the other keyframe.

** How to flip, invert, scale or move a keyframe line
Right-click in the Keyframes graph background, then choose the applicable option -- a great time-saver compared to manually
modifying an entire keyframe line with many keyframes.

** How to customize the Keyframes graph display
Right-click in the Keyframes graph background to access four Appearance options. Toggle Show grid to hide grid lines in the
graph. Toggle Show scroll bars to hide scroll bars (to slightly enlarge the graph area). Two other options may be useful,
depending on your screen space/layout. Save window position opens the Keyframes window at a consistent screen location.
Attach to main window keeps the Keyframes window attached if you move the main window. Any change will be remembered
automatically the next time you apply the effect.

** How to move a bezier handle that is on top of a keyframe
If you happen to drag a bezier handle directly on top of a different keyframe, later dragging may move both points. To move only
the bezier handle, first click the keyframe that "owns" that handle -- to activate it. Then Ctrl-drag the bezier handle where
desired.

** How to stay at a frame while adjusting keyframes elsewhere
The effect's default behavior is to show the image that corresponds to wherever you drag or adjust a keyframe in the graph. The
blue vertical playback marker therefore follows your movement in the graph. Sometimes, however, you may want to keep
viewing a particular frame while adjusting a keyframe elsewhere. Perhaps you want to adjust a bezier curve while seeing how it
alters an earlier or later frame's look. To do that, right-click in the graph's gray background and deselect Sync preview.

** How to snap a keyframe to the vertical playback marker position
When Sync preview is off (see above), sometimes you may need to move a keyframe to the blue vertical playback marker
position, such as when aligning a keyframe in one graph to a keyframe in another graph. To do that, position the playback
marker where desired, then right-click the keyframe you want to move and choose Snap to Time. The keyframe will then move to
the frame the playback marker is on. If that position is not possible because it is beyond an adjacent keyframe, the command will
not be available.
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More Keyframing Tips (continued)

** How to make automatic bezier curve adjustments
Instead of dragging a bezier handle to curve a keyframe line, you can right-click the keyframe and choose Convert keyframe to.
Then choose from the options shown below. To modify ALL keyframes in a graph, right-click in the keyframe graph gray background
and choose Convert all keyframes to. Then choose from the options shown below.

Linear -- remove all curves in the keyframe
Smooth -- decelerate before & accelerate after
Bounce -- accelerate before & decelerate after (opposite of smooth)
Smooth In -- decelerate before
Smooth Out -- accelerate after
Bounce In -- accelerate before
Bounce Out -- decelerate after

** Understanding keyframe lights
When the round keyframe light next to a control appears BRIGHT, the control's keyframing is active (thus its graph appears in
the Keyframes window).

BRIGHT green means there is NO keyframe for this control at the current frame (but you can add one).

BRIGHT blue means there IS a keyframe for this control at the current frame, which you can adjust in value by dragging the
control's slider.

A DULL light means the control is NOT active, but has been turned on previously. DULL green means there is NO keyframe for
this control at the current frame.

DULL blue means there IS a keyframe for this control at the current frame. This is useful to know if you want to sync a keyframe
for one control with another control's keyframe.

** You can do any keyframing steps (such as adding or moving keyframes) while the effect preview is stopped (the traditional
method), or while the preview plays.

** The maximum number of keyframes for a single control is 128. The maximum total number of keyframes for all controls is
1,000.
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Saving Favorite Effects

Each CreativEase effect includes a HUGE number of pre-made effects. You can also save your own custom effects. Favorite
effects, or even just certain settings or keyframes, can be instantly reapplied, saving time. Also, CreativEase's 100+ undo/redo
capability can temporarily retain settings so you can experiment further before applying an effect.

CreativEase (like our popular SpiceMASTER plug-in) has two ways to apply previously created effects -- section presets and
saved settings. Each offers different advantages to you: Section presets are accessed by a "light bulb" button atop certain
control sections -- they only affect controls in that section. Saved settings, unlike section presets, typically affect ALL controls
in the effect.

How to Apply a Section Preset

Click a light bulb at the upper right corner of a section, then choose a preset from the submenu. Trying presets is a quick and
easy way to overview a section's effects capabilities. Keep in mind you can do this while the CreativEase preview plays.

How to Apply a Saved Setting

1. Click the blue Load Saved Settings button in the black bar, as shown below. An Open dialog will appear to choose the
desired saved settings file. (If the CreativEase\[effect name]\Saved Settings folder is not open, navigate to it.)

2. Several subfolders of saved settings, organized by style, will appear in the Open dialog. Go into any subfolder and
click a save settings file. The settings will preview in the Animate box within the dialog, making it easy to choose a desired
file.

How to Create a New Saved Setting

1. Click the blue "+" Save Current Settings button in the black bar, as shown below. A Save As dialog will appear.

2. Name the file (be descriptive) and click the Save button.

Tips

** To save settings that (when loaded) will NOT change the current spice file, turn OFF the Include Spice check box in
the Save As dialog box when you create the saved setting.

** To load a saved setting but NOT change certain existing effect settings, before double-clicking the desired saved
setting file, activate the Choose Settings check box in the Open dialog. In the Import/Export Settings dialog that will appear, use
the OFF buttons to protect one or more sections of existing settings you want to keep.

** To undo any saved setting or section preset choice, click the Undo button at the top right of the effect's window. A 100+
undo/redo capability can temporarily retain settings so you can easily experiment!

** To select from most recently used saved settings, Ctrl-click the blue Load Saved Settings button.

** Saved settings can be transferred to other editing stations that have the same CreativEase effects installed. Just put the
saved settings file(S) you created in the other station's CreativEase\[effect name]\Saved Settings folder.

** If you have a cool saved setting to share with other users, please email attach it to support2@pixelan.com, include your
full contact info, and we will evaluate it for our web site, with you credited if it is posted.
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Changing the Default Settings

The new default will determine the spice file and settings that will appear initially the NEXT time you apply a CreativEase effect.
Changing the default is quick and easy:

1. Apply the CreativEase effect in your timeline so that its main dialog appears.

2. Choose a desired spice file and adjust effect controls as desired.

3. Click the Prefs tab, then click the Set button at the bottom of the pane.

To revert to the effect's "Factory" default, do either of the following steps:

** Click the Prefs tab, then click the Clear button (shown above). Clear will NOT change the current effect -- the new default
will appear the NEXT time you apply the effect. Note: Clear will not change the effect's preferences, which are retained
automatically when changed.

** To do the above AND clear the current effect's spice and settings to the "factory" default, Alt-click the yellow Clear
Settings (-) button in the CreativEase effect's black bar area.
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How to Choose a Spice File

Several CreativEase effects can utilize Pixélan's unique 'spice' files to guide where the effect will appear within the image.
Adapted from our popular SpiceMASTER plug-in, spices are simple in concept but wonderfully organic, flexible, and useful.
Two-hundred resolution-independent spices are provided, with additional spices available as an add-on from our web site. Spices
work much like an alpha channel mask, but are variable based on the value of the Spice Effect > Progress slider. Setting
Progress to 0, the effect appears only where blackest pixels reside in the spice file's image (NOT your clip's image) located at the
center of a CreativEase effect's window. Intermediate values mask the effect to appear only where grays reside in the spice
image. And finally, a Progress value of 100 limits an effect to only where the whitest pixels exist in the spice image. By
keyframing the Progress slider, the CreativEase effect will animate/flow during the clip, as shown below, which can add powerful
visual dynamics to the effect.

How to Choose a Spice File

1. Click the large Choose Spice File button located at the top middle of the CreativEase effect window. The Library window
will then appear.

2. Click a subfolder in the Library's left pane, as shown below. Thumbnail-size previews of available spices will then play
side-by-side in the right pane so you can visually compare and choose the best design for your desired effect.

Note: To see subfolders, click the "+" next to a folder in the left pane, if necessary. Subfolders organize the huge quantity of
effects into distinct styles.
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How to Choose a Spice File (continued)

3. Double-click a thumbnail in the Library's right pane to select the effect and close the Library. The grayscale image of the
chosen spice will then appear at the top center of the CreativEase effect's window, and its file name will be in the Choose Spice
File button. The effect's built-in preview will also immediately update to the effect. Or, single-click a thumbnail to load the
effect while keeping the Library open. Then you can try different spices "live" while loop-previewing the results! It's a powerful
way to compare and match spice effects to your content.

Tips

** Use the Mixer slider to modify the spice's geometry partially or entirely by the luminance (grayscale values) of your clip.This powerful
feature can quickly produce an enormous new range of mask geometries that visually relate to the imagery in your clips. Try the slider and see for
yourself!

** To quickly choose a spice you have used recently, click on the Prior Choices area below the Choose Spice File button. Up to nine prior choices will
appear in a pop-up list -- most recent first. (Note: "Prior Choices" are those that have been selected AND applied in the effect, not just viewed from the
Library.)

** Almost ANY still-image can be loaded as a custom spice file, giving you even more creative flexibility. For example, you may want to use a
client logo graphic to define the effect area. The luminance (grayscale values) of the loaded image will determine the geometry of the mask. To
load a custom spice file (bypassing the Library), Ctrl-click the Choose Spice File button to get a standard Open dialog box. Then navigate to and
select the file. To instead add one or more new still-images into the Library PERMANENTLY (so they are always available to you), see
Adding/Deleting Effects in the Library. Note that such images are NOT resolution-independent like our unique spice files. For cleanest results, therefore,
any loaded still-image should match the final frame size of your output (such as 720x480 pixels for DV).

** To combine spice designs to create a 'new' spice effect, apply the effect more than once to the same clip, but choose different spice files each time
(or invert, flip or move the same spice). This technique multiplies hundreds of provided spices into an near-infinite range of effect designs!

** CreativEase opens with a default effect. To change the default to a different spice file and/or effect setting, choose a spice and adjust the
effect as desired, then click the Set button in the Prefs pane. The new default will appear the NEXT time you apply the CreativEase effect.
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Flip, Reverse, Move, or Rotate the Spice Mask
After choosing a spice file, it will appear at the top center of the CreativEase effect window. Then you can adjust it several ways, such as flipping or
reversing the effect mask, moving it to a new position, or putting it in motion. You can even rotate it and create terrific spin effects. Use these controls to
better tie the effect to your content, or to add variety when repeating an effect.

A. Position -- Drag the orange handle's center to move the effect. To move ONLY horizontally/vertically, Shift-drag.

B. Rotate -- Drag the outer circle of the orange handle to rotate the effect.
C. Center (Alt-5) -- Re-center a moved effect.
D. Clear Rotation (Alt-6) -- Remove rotation from a rotated effect.
E. H Flip (Alt-7) -- Flip the effect horizontally.
F. V Flip (Alt-8) -- Flip the effect vertically.
G. Invert (Alt-9) -- Invert the effect mask.

More About Moving an Effect

** To set a precise position, enter X and Y coordinates under the spice image, as shown below. The top left frame corner is 0,0 and the bottom right
corner is 1,1. To position an iris spice effect precisely at the top left third point, for example, enter X = .33 and Y = .33.

** To move the effect over time�
1. Turn on a keyframe light next to the X or Y box. (Both will turn on together.)

2. Go to a desired frame that you want to set a rotation value for. There are many ways to do this. You can click the playback buttons or drag the slider
below the built-in preview. (In the Sony Vegas/Vegas Movie Studio version, instead just go to a different frame of the same clip in your Vegas timeline.) In
all versions of CreativEase, you can also drag the blue vertical frame marker in the Keyframes graph.

3. Now move the spice to a new position, as explained at the top of this page. With the X/Y keyframe lights on, that will form a new keyframe, which you
can further modify in the Keyframes area. Repeat this step as desired to set additional keyframes for the movement.
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Flip, Reverse, Move, or Rotate the Spice Mask (cont.)

How to Rotate or Spin the Effect

To rotate the spice mask, drag the outer ring of the orange handle in the spice file image. Or enter a rotation value in the R
box below the image. From -3600 degrees to 3600 degrees is possible (20 full rotations in either direction).

To remove rotation, click the Clear Rotation button shown at the top of this page. (Or tap Alt-6 keys.)

To rotate or spin the effect over time�
1. Turn on the keyframe light next to the R box.

2. Go to a desired frame that you want to set a rotation value for. There are many ways to do this. You can click the playback
buttons or drag the slider below the built-in preview. (In the Sony Vegas/Vegas Movie Studio version, instead just go to a
different frame of the same clip in your Vegas timeline.) In all versions of CreativEase, you can also drag the blue vertical frame
marker in the Keyframes graph.

3. Now rotate the spice, as described above. With the R keyframe light on, that will form a new keyframe, which you can further
modify in the Keyframes area. Be sure to also turn on the Oversize to Spin button (shown below) if you are using an Iris
spice -- to keep the spice size consistent during spins. (CreativEase normally will slightly vary a rotated spice's size to ensure it
covers the entire frame.)

** Moving or rotating certain spices may reduce the range of grayscales in the visible frame. If you also are keyframing the
Progress slider from 0 to 100, the spice mask may not start/end exactly at the actual beginning or end of the effect. To
compensate (especially if an iris-like effect), turn on the Auto-Adjust button. Applying some Softness also can be useful,
especially for effects that last several seconds.

If the results are not satisfactory, turn off the Auto-Adjust button and manually adjust the effect's first (and/or last)
Completion keyframes up (and/or down) (such as 20% - 80% instead of the default 0% - 100%) to fine-tune the effect's visual
timing.
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Customizing the Library
With hundreds of available spices, choosing one could be tedious. Fortunately, CreativEase (like our popular SpiceMASTER plug-in) includes a visual,
interactive Library -- a great tool to compare and select the best spice for your desired effect. The Library shows spices as small side-by-side thumbnail
animations -- much better than trying to choose from a long list of file names or icons!

How to choose a spice file is covered on this page. Below shows how you can customize the Library and use its powerful management features. For
example, you can create virtual folders of favorite (or project specific) spices. Spice file names can be color-coded for later reference or to help you mark
and narrow choices. Also, you can adjust viewing options to tailor the Library to your working style.

Customizing the Library Display

To customize the Library display, click its Toolbar buttons to change the thumbnail style, softness, play direction, speed, and size. Equivalent commands
are also in Library menus.

a. Play/Stop Preview -- Play or stop the thumbnail animations. Stopping will reveal the grayscale design that represents each spice's geometry.
b. Preview Speed -- Speed or slow the animation.
c. Reverse Preview -- Play forward only or reverse loop.
d. Preview Softness -- Play with or without edge softness.
e. Change Preview Size -- Increase or decrease the thumbnail size.

Keep in mind you also can adjust the size and location of the Library window (and drag between its two panes to adjust their width). You also can minimize
the Library window.

Tips

** To play only one spice animation in the Library while others do NOT play, click the Play/Stop Preview button to stop all animation. Then
right-click a thumbnail and choose Animate. Repeat as often as desired, such as when you have narrowed your choice to two or three spice candidates.

** To color a thumbnail name as a way to mark possible effects (such as favorites, or potential choices), right-click the thumbnail and choose a color.
The color will remain until you right-click and choose Black.

** To hide part of the Library to have more viewing space for thumbnails, you can uncheck the status bar, toolbar, or left pane in the Options menu
of the Library. Also, you can toggle the Library window's tiling (automatic placement under the main CreativEase effect window) with the Tile Library
Window command.
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Customizing the Library (continued)

Organizing Existing Spices

Create "virtual folders" to further organize Library spices into any group, such as spices for a particular project or type of production. Virtual folders only
exist within CreativEase. Create as many as you want, with no penalty in disk space or speed. A Favorites virtual folder is already created for you,
ready made to accept spices from anywhere else in the Library. To create another virtual folder, click the blue Add Virtual Folder button (shown below)
in the Library toolbar (or choose Edit > Add Virtual Folder).

Then enter the desired name of the folder in the small dialog box that will appear. The new virtual folder will then appear at the top of the Library's left
pane. To later rename of the virtual folder, right-click it and choose Rename Folder.

To add a spice effect to the Favorites folder (or your virtual folder), first display the spice in the Library's right pane, then drag and drop its
thumbnail into the Favorites folder (or your virtual folder) in the Library's left pane. A duplicate will then reside there (no additional disk space required).

Tips

** To create a subfolder within a virtual folder, right-click the blue virtual folder in the left pane and choose Add SubFolder.

** To delete an unwanted spice or folder, right-click any thumbnail (or folder) in the Library, then choose Delete Icon (or Delete Folder). Or select a
folder in the left pane and choose Edit > Delete Selected Folder. Either way, a warning dialog box will appear to confirm your choice. Deletion will ONLY
remove it from the Library display, NOT from your drive. That way it can be restored later if desired (see below).

** To refresh/restore/update a Library folder's contents, right-click the folder in the Library's left pane, then choose Refresh Folder.

Adding/Deleting Effects to the Library

The Library holds several hundred spices that ship with CreativEase, plus there are additional collections available as add-ons from our web site. This
provides a range wide enough to cover most effect mask designs you will ever need. However, the Library is open-ended so you can add other still-images
you have created (or acquired elsewhere). For example, you may want to use a client logo graphic to define the effect area. The luminance (grayscale
values) of the still-image will determine the geometry of the mask.

An existing Your Custom Files folder is already visible in the Library, handy for adding other still-image files to the Library. That folder is
located at ..\Pixelan\CreativEase\Shared Files\Spices\Your Custom Files within your editing software's folder (except for the Sony Vegas/Vegas Movie
Studio version which has a separate Program Files\Pixelan folder). Simply drop a new file into the Your Custom Files subfolder and it will automatically
appear the next time you open the Library.

To add an individual effect to a different Library folder than the Your Custom Files folder, first create a virtual folder in the Library (unless you
want to add it to the existing Favorites virtual folder). Then right-click the virtual folder and choose Add Spice. (Or with that folder selected, click the Add
Spice button in the toolbar, or choose File > Add Spice.) In the Open dialog that will appear, navigate to and select the desired file.

To permanently add an entire folder of additional effects to the Library, click the yellow Add Source Folder button (shown below) in the Library's
toolbar (or choose Edit > Add Source Folder). This can be handy if you have a entire set of gradient or alpha wipe files, for example, from another product
that you wish to have available in the Library.

In the dialog that will appear, double-click the drive that holds the additional folder of effects. Navigate until you can select that additional folder of
effects, then click OK. The selected folder will then appear in the Library's left pane, like any spice folder.

To delete an effect or folder, right-click any thumbnail (or folder) in the Library, then choose Delete Icon (or Delete Folder). Or select a folder in the left
pane and choose Edit > Delete Selected Folder.
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Preferences
Preference settings are in the Prefs pane at the right half of the effect's interface. All preferences there are global -- thus will be retained for each future
time you apply the same CreativEase effect. (Note that changing preferences in one effect, such as PosterWise, will not change the same preferences in a
different CreativEase effect.)

The Sony verson of CreativEase previews real-time in the Vegas preview window. In other versions, the built-in preview in CreativEase effects can usually
maintain a real-time pace, even on older/slower computers. If you find that the preview falls below a real-time pace, turn on either of the two options below
to speed an effect's built-in preview toward real-time performance and to make effect adjustments update quickly. To temporarily turn on an option ONLY
for the next time you preview, use the keyboard shortcut shown below with the blue Play button located under the preview.

No UI update [Alt-Play] Not available in Sony version
Turn on to have the effect's interface (sliders, etc.) not update during playback.

Drop frames if necessary [Ctrl-Play] Not available in Sony version
Turn on to drop frames if necessary to maintain the clip's pacing. Therefore a 2-second clip will actually preview in 2 seconds, for example. Dropped
frames appear only in the preview, not final output.

Compare effect to source Not available in Sony version
Turn on to show the effect in only half of the built-in preview (shown below). This can be handy when evaluating the visual impact of a particular effect.

Match to Monitor Not available in Sony version
When on, CreativEase will preview just like your editing system's timeline preview, thus including any other effects that also may be applied to the clip.
Turn off to see only the CreativEase effect, which in some editing situations may be more useful for making adjustments.

Broadcast colors
While on, selected Border colors will more likely be "safe" for broadcast -- not too saturated or pure white/black. (Awareness of the safe issue while
choosing colors is the best precaution, though.) It constrains RGB values to 16-235. For multimedia output, turn this option off to have the full color range
available.

Reverse fields Not available in Sony version
Certain editing system configurations may produce reverse field artifacts in CreativEase output where motion occurs. This option solves the problem.

Reverse spice Not available in Sony version
If Reverse fields is on (see above), sometimes this option should also be turned on to show a clean edge around curved spice geometries. Only applicable to
CreativEase effects with spices.

Auto-close Video Event FX window Sony version only
Turn on if you prefer that the Video Event FX window of Vegas disappears automatically after applying a CreativEase effect.

Hide Video Event FX window Sony version only
Turn on if you prefer that the Video Event FX window of Vegas disappears when a CreativEase window is open, reducing on-screen clutter.

Time Units Not available in Sony version
This option affects the display of the Current Frame and Duration indicators below the effect's preview. Choose relative Timecode or relative Frames.

Show pop-up text
On shows a brief text description when the cursor is held over certain interface areas. Turn it off if that info becomes a nuisance.

Confirm clearing/exiting
With this option on, when clearing keyframes you will be asked for confirmation -- a good safety net for most users to prevent accidental deletion. Also, you
will be asked for confirming before exiting the window without changes so you won't accidentally lose a cool effect you've set up.

Make current FX settings the default
To set a new default effect, adjust settings as desired, then click the Set button. To set the default (except for preferences) back to the effect's "factory"
default, click the Clear button. With either button, the new default will appear the NEXT time you apply the effect.

To clear the current effect's settings back to your default, click the yellow Clear '-' button in the black bar area of the effect.
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Keyboard Shortcuts

Help -- F1
Undo -- Ctrl-Z
Redo -- Ctrl-X

Control Values
0 -- Home
100 -- End
Decrease by 20 -- Page Up
Increase by 20 -- Page Down
Increase by .1 -- Right or Down Arrow
Decrease by .1 -- Left or Up Arrow

Cycle through controls -- Tab

Keyframes
Select first keyframe -- A
Select prior keyframe -- S
Select next keyframe -- D
Select last keyframe -- F

Playback
Play/Stop -- X
First frame -- Q
Prior frame -- W
Next frame -- E
Last frame -- R
No image update -- Shift-Play
No UI update -- Alt-Play
Drop frames if necessary -- Ctrl-Play

General
Apply current settings -- Enter
Load Saved Settings -- Alt-L
Save Current Settings -- Alt-S
Clear Settings -- Alt-C
Exit without changes -- Esc
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